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Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance.
Product design and specifications may be changed without notice.

License

Without producing harmful VOC (Volatile Organic Compounds), Samsung’s Eco-friendly “Crystal Design” 
expresses colour gradation thanks to our dual injection technology.

 

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology is 
incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories.

DivX® Certified to play DivX® video, including premium content.

Precautions When Displaying a Still Image
A still image may cause permanent damage to the TV screen

Do not display still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 
This image retention is also known as “screen burn”. To avoid such image retention, reduce the degree of brightness and 
contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 
a game console may cause a similar effect to the screen. Damages caused by the above effect are not 
covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 
prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.

© 2009 Samsung Electronics Co., Ltd. All rights reserved.

❑

❑

●

●

●

ABOUT DIVX VIDEO: DivX® is a digital video format created by DivX,Inc. This is an official DivX Certified device that plays 
DivX video. Visit www.divx.com for more information and software tools to convert your files into DivX video.
ABOUT DIVX VIDEO-ON-DEMAND: This DivX Certified® device must be registered in order to play DivX Video-on-Demand 
(VOD) content. To generate the registration code, locate the DivX VOD section in the device setup menu. Go to vod.divx.com 
with this code to complete the registration process and learn more about DivX VOD.
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CONNECTING AND PREPARING YOUR TV

Viewing the Control Panel
The product colour and shape may vary depending on the model.
The front panel buttons can be activated by touching them with your finger.

1	 REMOTE CONTROL SENSOR
Aim the remote control towards this spot on the TV.

2	 SOURCEE
Toggles between all the available input sources. In the on-screen menu, use this button as you would use the ENTERE 
button on the remote control.

3	 MENU
Press to see an on-screen menu of your TV’s features.

4	 – VOL +
Press to increase or decrease the volume.
In the on-screen menu, use the – VOL + buttons as you would use the ◄ and ► buttons on the remote control.

5	 > CH <
Press to change channels. In the on-screen menu, use the > CH < buttons as you would use the ▼ and ▲ buttons on the 
remote control.

6	 POWER INDICATOR
Blinks and turns off when the power is on and lights up in stand-by mode.

7	 P (POWER)
Press to turn the TV on and off.

8	 SPEAKERS

¦

N
N

8 8
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Accessories

Remote Control & Batteries (AAA x 2) Power Cord Holder-Wire Cable 
(depending on the model)

 
(M4 X L16)

Programme CD Cleaning Cloth Cover-Bottom Stand Screw X 4
(depending on the model)

Owner’s Instructions ● Warranty card● Safety Guide● Registration Cards●

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.
Warranty card / Safety Guide / Registration Cards (Not available in all locations)
The items colour and shape may vary depending on the model.

¦

N
N
N
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Viewing the Connection Panel

The product colour and shape may vary depending on the model.
Whenever you connect an external device to your TV, make sure that power on the unit is turned off.
When connecting an external device, match the colour of the connection terminal to the cable.

1	 AV IN 1, 2 [VIDEO] / [R-AUDIO-L]
Connect RCA cable to an appropriate external A/V device such as VCR, DVD or Camcorder.
Connect RCA audio cables to [R-AUDIO-L] on your set and the other ends to corresponding audio out connectors on the 
A/V device.

2	 HDMI IN 1, HDMI IN 2, HDMI IN 3(DVI), HDMI IN 4
Supports connections between HDMI-connection-enabled AV devices (Set-Top Boxes, DVD players)
No additional Audio connection is needed for an HDMI to HDMI connection.
When using an HDMI / DVI cable connection, you must use the HDMI IN 3(DVI) jack.
What is HDMI?
‘High Definition Multimedia interface’ allows the transmission of high definition digital video data and multiple channels of 
digital audio.
The HDMI / DVI terminal supports DVI connection to an extended device with the appropriate cable (not supplied).
The difference between HDMI and DVI is that the HDMI device is smaller in size, has the HDCP (High Bandwidth Digital 
Copy Protection) coding feature installed, and supports multi - channel digital audio.
The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable 
Boxes / Satellite receivers supporting HDMI versions older than 1.3 are connected. When connecting an older HDMI 
cable and there is no sound, connect the HDMI cable to the HDMI IN 3(DVI) jack and the audio cables to the DVI AUDIO 
IN jacks on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / Cable Box / 
Satellite receiver to confirm the HDMI version, then request a firmware update. HDMI cables that are not 1.3 may cause 
annoying flicker or no screen display.
Supported modes for HDMI / DVI and Component.

480i 480p 576i 576p 720p 1080i 1080p
HDMI / DVI 50Hz X X X O O O O
HDMI / DVI 60Hz X O O X O O O

Component O O O O O O O

3	 DVI AUDIO IN
DVI audio outputs for external devices.

4	 PC IN [PC] / [AUDIO]
Connect to the video and audio output jack on your PC.

5	 ANT IN
To view television channels correctly, a signal must be received by the set from one of the following sources: An outdoor 
aerial / A cable television network

6	 LAN
Connect a LAN cable to this port to connect to the Network.

¦

N
N
N

–
–

–
–
–
N

N
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–
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[TV Side Panel]

[TV Rear Panel]

Power Input
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7	K ENSINGTON LOCK (depending on the model)
The Kensington Lock (optional) is a device used to physically fix the system when used in a public place.
If you want to use a locking device, contact the dealer where you purchased the TV.
The location of the Kensington Lock may be different depending on its model.

8	 H (HEADPHONE)
Headphone may be connected to the headphone output on your set. While the head phone is connected, the sound from 
the built-in speakers will be disabled.
Using the sound function is restricted when connecting headphones to the TV.
Prolonged use of headphones at a high volume may damage your hearing.
You will not hear sound from the speakers when you connect headphones to the TV.
The headphone volume and TV volume are adjusted separately.

9	 AUDIO OUT [R-AUDIO-L]
Connect RCA audio cables to AUDIO OUT [R-AUDIO-L] on the rear of your set and the other ends to corresponding 
audio in connectors on the Amplifier or DVD Home Theatre.

0	 DIGITAL AUDIO OUT (OPTICAL)
Connects to a Digital Audio component.
When a Digital Audio System is connected to the DIGITAL AUDIO OUT (OPTICAL) jack: Decrease the volume of the TV 
and adjust the volume level with the system’s volume control.
5.1CH audio is possible when the TV is connected to an external device supporting 5.1CH.

!	 SERVICE
Connector for service only.

@	 COMPONENT IN 1, 2
Connect component video cables (optional) to component connector (PR, PB, Y) on the rear of your set and the other ends 
to corresponding component video out connectors on the DVD.
If you wish to connect both the Set-Top Box and DVD, you should connect the Set-Top Box to the DVD and connect the 
DVD to component connector (PR, PB, Y) on your set.
The PR, PB and Y connectors on your component devices DVD are sometimes labeled Y, B-Y and R-Y or Y, Cb and Cr.
Connect RCA audio cables (optional) to [R-AUDIO-L] on the rear of your set and the other ends to corresponding audio 
out connectors on the DVD.

#	 USB1(HDD) / USB2
Connector for software upgrades and Media Play, etc.
You can connect to Samsung’s network wirelessly using the ‘Samsung Wireless LAN Adapter’ (Sold separately).
For USB HDD, use the USB1 (HDD) port.

–
–
–

–

N
N
N
N

–

–
N

N

–

–

–

–
–

–
–
N
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Viewing the Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

1	 POWER: Turns the TV on and 
off.

2	 TV: Selects the TV mode directly.
3	 NUMERIC BUTTONS: Press to 

change the channel.
4	 E: Performs the same function 

as the ENTERE key of the 
directional keys. When switching 
channels with the numeric 
buttons, and you press the 
channel number and then the 
ENTERE key, the channel is 
immediately switched.

5	 Y: Press to increase or 
decrease the volume.

6	 SOURCE: Press to display 
and select the available video 
sources.

7	 CH LIST: Used to display 
Channel Lists on the screen.

8	 TOOLS: Use to quickly select 
frequently used functions.

9	 INTERNET@: Press to use 
various internet services to 
view useful information and 
entertaining content.  
(Australia, Singapore only)

0	 COLOURS BUTTONS: Use 
these buttons in the Channel 
list, Internet@TV, Media play 
menu, etc.

@	 INFO: Press to display 
information on the TV screen.

#	 Use these buttons in the Media 
Play (USB & DLNA) and 
Anynet+. (∏: This remote can 
be used to control recording on 
Samsung recorders with the 
Anynet+ feature)

$	 ON/OFF @: Pressing the 
ON/OFF @ light button toggles 
between on and off. When the 
remote control is on, and a key 
is pressed on the remote control, 
the remote control buttons will 
be lit for a moment. (Using the 
remote control with the ON/OFF 
@ light button set to On will 
reduce the battery usage time.)

%	 PRE-CH: Enables you to return 
to the previous channel you were 
watching.

^	 MUTE: Press to temporarily cut 
off the sound.

&	 P </P >: Press to change 
channels.

*	 MENU: Displays the main on-
screen menu

(	 FAV.CH: Used to display 
Favourites Channel Lists on the 
screen.

)	 RETURN: Returns to the 
previous menu

a	 UP▲ / DOWN▼ / LEFT◄ / 
RIGHT► / ENTERE: Use to 
select on-screen menu items and 
change menu values.

b	 EXIT: Press to exit the menu.
c	 CONTENT: This function enables 

you to view the Content Library. 
(see page 53)

d	 MEDIA.P: Allows you to play 
music files, pictures, and movies.

e	 SUBT.: Digital subtitle display
f	 GUIDE: Electronic Programme 

Guide (EPG) display.  

Teletext Functions
2	 :: Exit from the teletext display
6	 0: Teletext mode selection 

(LIST / FLOF)
7	 8: Teletext store
8	 4: Teletext size selection
0	 Fastext topic selection
!	 /: Alternately select 

Teletext, Double, or Mix.
@	 5: Teletext reveal
%	 1: Teletext sub page
&	 2: Teletext next page

3: Teletext previous page
*	 6: Teletext index
)	 9: Teletext hold
b	 7: Teletext cancel

¦

N
N
N
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Installing Batteries in the Remote Control
1.	 Lift the cover at the back of the remote control upward as shown in the figure.
2.	 Install two AAA size batteries.

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 
compartment.

3.	 Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using the 
remote control for a long time.

If the remote control doesn’t work, check the following:
Is the TV power on?
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?

OPERATION

Viewing the menus
Before using the TV, follow the steps below to learn how to navigate the menu in order to select and adjust different functions.

  

Operation the OSD (On Screen Display)
The access step may differ depending on the selected menu.
1.	 Press the MENU button.

2.	 The main menu appears on the screen. The menu’s left side has icons : Picture, Sound, 
Channel, Setup, Input, Application, Support.

3.	 Press the ▲ or ▼ button to select one of the icons.

4.	 Then press the ENTERE button to access the icon’s sub-menu.
5.	 Press the ▲ or ▼ button to select the icon’s submenu.

6.	 Press the ◄ or ► button to decrease or increase the value of a particular item. The 
adjustment OSD may differ depending on the selected menu.

7.	 Press the ENTERE button to complete the configuration. Press the EXIT button to exit.

¦

N

N

N
–
–
–
–
–

¦

❑

MENU Button 
Display the main on-screen menu.

ENTERE / DIRECTION Buttons
Move the cursor and select an 

item. Select the currently selected 
item. Confirm the setting.

RETURN Button
Return to the previous menu.

EXIT
Exit the on-screen menu.

Mode	 : Standard	 ▶

Backlight	 : 7
Contrast	 : 95
Brightness	 : 45
Sharpness	 : 50
Colour	 : 50
Tint (G/R)	 : G50/R50
Advanced Settings

Picture

Mode	 : Standard

Backlight	 : 7	 ▶

Contrast	 : 95
Brightness	 : 45
Sharpness	 : 50
Colour	 : 50
Tint (G/R)	 : G50/R50
Advanced Settings
Picture Options

Picture

7

 U Move    L Adjust     E Enter     R Return

      ▲
Backlight
      ▼

Help icon
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Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and subsequently.
1.	 Press the POWER button on the remote control. 

The message Select ‘Home Use’ when installing this TV in your home. is 
displayed.
The factory default setting for the picture will be Standard. 
Standard mode is the recommended home viewing picture mode.
You can also use the POWERP button on the TV.

2.	 Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button.
We recommend setting the TV to Home Use mode for the best picture in your home 
environment.
Store Demo mode is only intended for use in retail environments.
If the unit is accidentally set to Store Demo mode and you want to return to Home Use (Standard): Press the Volume 
button on the TV. When the volume OSD is displayed, press and hold the MENU button on the TV for 5 seconds.

3.	 Press the ENTERE button. Select the appropriate country by pressing the ▲ or ▼ button. Press the ENTERE button to 
confirm your choice.

4.	 Press the ▲ or ▼ button to select the channel source to memorize. Press the ENTERE button to select Start.
Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.
The channel search will start and end automatically.
Press the ENTERE button at any time to interrupt the memorization process.
After all the available channels are stored, the message Set the Clock Mode. is displayed.

5.	 Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then Press the ENTERE button.
If you select Manual, Set current date and time is displayed.
If you have received a digital signal, the time will be set automatically. If not, select Manual to set the clock.

6.	 Press the ▲ or ▼ button to highlight the time zone for your local area. Press the ENTERE button. (Australia only)
7.	 The description for the connection method providing the best HD screen quality is displayed. Check the description and press 

the ENTERE button.
8.	 Press the ◄ or ► button to select See Product Guide or Watch TV, then the ENTERE button.

See Product Guide: You are moved to the Product Guide where you can view the introduction to the main functions of 
your new HDTV.
Watch TV: You can watch the set broadcasting channel.

If you want to return to this feature...
1.	 Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, then press the ENTERE button.
2.	 Press the ENTERE button again to select Plug & Play. 
3.	 Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’.

If you want to change PIN number, use the Change PIN function. (refer to page 21)
The Plug & Play feature is only available in the TV mode.
Any previous settings and adjustments will remain including the picture mode. 
All Channel settings will be lost.
For home viewing, ensure the picture mode is set to Standard.

¦

N

N
N
N

N

N
N

●
●
●
N
N
N

N
N

●

●

N
N
N
N
N

CHANNEL CONTROL

Configuring the Channel Menu

Country (depending on the country)
You can change the country. 

The PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting 
Change PIN from the menu.
Some functions may not be supported depending on the selected country.

¦

❑

N
N

N

Plug & Play

Select ‘Home Use’ when installing this TV in your 
home.

Store Demo
L Move   E Enter

Home Use

Country			  : Australia	 ►

Auto Store
Manual Store
Full Guide
Mini Guide
Default Guide		  : Full Guide
Channel List
Channel Mode		  : Added Ch.

Channel
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Auto Store
You can scan for the frequency ranges available to you (and availability depends on your country).
Automatically allocated programme numbers may not correspond to actual or desired programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.

Air / Cable
Antenna source to memorize

Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.
Scans for all channels with active broadcast stations and stores them in the TV’s memory.
If you want to stop Auto Store, press the ENTERE button.
The Stop Auto Store? message will be displayed.
Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

Manual Store
Scans for a channel manually and stores it in the TV’s memory.
If a channel is locked using the Child Lock function, the PIN input window appears.

Digital Channel
Manual store for digital channels.

Digital Channel is only available in digital TV mode.
Channel: Set the Channel number using the ▲, ▼ or number (0~9) buttons.
Frequency: Set the frequency using the number buttons.
Bandwidth: Set the bandwidth using the ▲, ▼ or number (0~9) buttons.
When it has finished, channels are updated in the channel list.

Analogue Channel
Manual store for analogue channel.

Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.
Colour System → Auto / PAL / SECAM / NTSC4.43: Sets the colour system value using the ▲ or ▼ button.
Sound System → BG / DK / I / L: Sets the sound system value using the ▲ or ▼ button.
Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 
(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.

You can also select the channel number directly by pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect the sound standard required.

Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.
Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.
Channel mode

P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 
numbers from P00 to P99. You can select a channel by entering the position number in this mode.
C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 
mode.
S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

Full Guide / Mini Guide
The EPG (Electronic Programme Guide) information is provided by the broadcasters. Programme entries may appear blank or out 
of date as a result of the information broadcast on a given channel. The display will dynamically update as soon as new information 
becomes available.

You can also display the guide menu simply by pressing the GUIDE button. (To configure the Default Guide, refer to the 
descriptions.)
In New Zealand, If Digital Text is set to Enable, the EPG (Electronic Program Guide) will work. (refer to page 22)

Full Guide
Displays the programme information as time ordered One hour segments. Two hours of programme information is displayed which 
may be scrolled forwards or backwards in time.

Mini Guide
The information of each programme is displayed by each line on the current channel Mini Guide screen from the current 
programme onwards according to the programme starting time order.
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Default Guide → Mini Guide / Full Guide (Australia & Singapore Only)
You can decide whether to display either the Mini Guide or the Full Guide when the GUIDE button on the remote control is 
pressed.

Channel List
For the detailed procedures on using the Channel List, refer to page 11.

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode
When press the P >/< button, Channels will be switched within the selected channel list.

Added Ch.
Channels will be switched within the memorized channel list.

Favourite Ch.
Channels will be switched within the favourite channel list.

Fine Tune
If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 
operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk “*” on the right-hand side of the channel number in the 
channel banner.
To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button.
Only Analogue TV channels can be fine tuned.

Using the Full / Mini Guide

Full Guide
DTV Cable 900 f tn                       Tue, 1 Jun 2:10 am
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Today 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

900       f tn
901       ITV Play
902       Kerrang!
903       Kiss
903       oneword
903       Smash Hits!▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

 Watch          Information     Page    ■ Mini Guide    ■ +24 Hours    ■ Exit

Mini Guide DTV Cable 900 f tn

Street Hypnosis
Booze Britain

2:00
2:30
5:00▼

Freshmen On Campus

 Watch              Information       Page     ■ Full Guide     ■ Exit

To... Then...
Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.
Exit the guide Press the blue button
If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press the 
◄, ► button to select Cancel Schedules, the scheduling is canceled with the clock icon gone. 
View programme information Select a programme of your choice by pressing the ▲, ▼, ◄, ► button.

Then press the INFO button when the programme of your choice is 
highlighted.
The programme title is on the upper part of the screen center. 

Please click on INFO button for the detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video Quality 
Information (HD / SD), Sound Modes, Subtitle or Teletext, languages of Subtitle or Teletext and brief summary of the highlighted 
programme are included on the detailed information. “...” will be appeared if the summary is long.
Toggle between the Mini Guide or Full Guide Press the red button repeatedly.
In Full Guide
Scrolls backwards quickly (24 hours).
Scrolls forwards quickly (24 hours).

Press the green button repeatedly.
Press the yellow button repeatedly.
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Managing Channels
Using this menu, you can add / delete or set favourite channels and use the programme guide 
for digital broadcasts.

All Channels
Shows all currently available channels.

Added Channels
Shows all added channels.

Favourites
Shows all favourite channels.

To select the favourites channels you have set up, press the FAV.CH button on the remote control.

Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.
Using the Colour buttons with the Channel List 

Red (Channel Type): Toggle between your TV, Radio, Data / Other and All.
Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists. You can perform the Add / Delete, Add to Favourite / Delete from 
Favourite or Lock / Unlock function for multiple channels at the same time. Select the required channels and press the 
yellow button to set all the selected channels at the same time.
TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 
Viewing, Edit Channel Name, Edit Channel Number, Sort, Select All (or Deselect All) or Auto Store menu. (The 
Options menus may differ depending on the situation.)

Channel Status Display Icons
A	 : An Analogue channel. 
c	: A channel selected by pressing the yellow button.
*	 : A channel set as a Favourite. 
(	 : A programme currently being broadcast.
\	 : A locked channel.
)	 : A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)
Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel status.

Add / Delete
You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.
A gray-coloured channel indicates the channel has been deleted. 
The Add menu only appears for deleted channels.
You can also delete a channel to the Added Channels or Favourites menu in the same 
manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

The ♥ symbol will be displayed and the channel will be set as a favourite.
All favourite channels will be shown on Favourite menu.
Press the TOOLS button to display the Tools menu. You can also set the Add to Favourite by selecting Tools → Add to 
Favourite.

Lock / Unlock
You can lock a channel so that the channel cannot be selected and viewed. This function is available only when the Child Lock is 
set to On. (see page 21)

The PIN number input screen appears. Enter your 4 digit PIN number. 
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN, by selecting Change PIN from the menu.
The \ symbol will be displayed and the channel will be locked.
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A1		  C --
A2		  C --

A 3		  C --
A 4		  C --
A 5	 ♥	 C --	
A 6		  C --
A 7		  C --
A 8		  C --
A 9		  C --
A 10		  C --

Added Channels
               Air           Channel Type     Zoom      Select     T Tools

A1		  C --
A2		  C --

A 3		  C --
A 4		  C --
A 5	 ♥	 C --	
A 6		  C --
A 7		  C --
A 8		  C --
A 9		  C --
A 10		  C --

All Channels

                 Air         Channel Type     Zoom      Select     T Tools

Delete
Add to Favourite
Lock
Timer Viewing
Edit Channel Name
Sort

▼
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Timer Viewing
If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 
even when you are watching another channel. To reserve a programme, set the current time first. (See page 20)

Only memorized channels can be reserved.
You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Reserving a programme will be shown on Programmed menu.
Digital Programme Guide and Viewing Reservation
When a digital channel is selected, and you press the ► button, the Programme Guide for the channel appears. You can 
reserve a programme according to the procedures described above.

Edit Channel Name (analogue channels only)
Channels can labeled so that their call letters appear whenever the channel is selected.

The names of digital broadcasting channels are automatically assigned and cannot be labeled.

Edit Channel Number (digital channels only) (Australia, Singapore only)
You can also edit the channel number by pressing the number buttons on the remote control.

Sort (analogue channels only)
This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 
the auto store.

Select All / Deselect All
Select All: You can select all the channels in the channel list.
Deselect All: You can deselect all the selected channels by pressing the yellow button.
You can perform the add / delete, add to Favourites / delete from Favourites, or lock / unlock function for multiple channels at 
the same time. Select the required channels and press the yellow button to set all the selected channels at the same time.
The c mark appears to the left of the selected channels.
You can only select Deselect All when there is a selected channel.

Auto Store
For further details on setting up options, refer to page 9.
If a channel is locked using the Child Lock function, the PIN input window appears.

Channel List Option Menu (in Programmed)
You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.

Change Info
Select to change a viewing reservation.

Cancel Schedules
Select to cancel a viewing reservation.

Information
Select to view a viewing reservation. (You can also change the reservation information.)

Select All
Select all reserved programmes.
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1 / 1 / 2009

01:59 pm    5            ) 

2 / 1 / 2009

06:59 pm      2               ) The Equalizer

08:59 pm      2               ) McMillan & Wife

07:59 am      2               ) M.Spillane’s mike 

Programmed

                 Air         Zoom      Select     T Tools     E Information

Change Info
Cancel Schedules
Information
Select All
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PICTURE CONTROL

Configuring the Picture Menu

Mode
You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also configure the picture 
mode by selecting Tools → Picture Mode.

Dynamic
Selects the picture for increased definition in a bright room.

Standard
Selects the picture for the optimum display in a normal environment.

Natural
Selects the picture for optimum and eye-comfortable display.

This function is not available in PC mode.

Movie
Selects the picture for viewing movies in a dark room. 

Backlight / Contrast / Brightness / Sharpness / Colour / Tint(G/R)
Your television has several setting options that allow you to control the picture quality.

Backlight
Adjusts the brightness of LCD back light.

Contrast
Adjusts the contrast level of the picture.

Brightness
Adjusts the brightness level of the picture

Sharpness
Adjusts the edge definition of the picture.

Colour
Adjusts colour saturation of the picture.

Tint(G/R)
Adjusts the colour tint of the picture.

Select a picture mode to be adjusted first. The adjusted values are saved for each picture mode.
When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint(G/R), the OSD will be adjusted 
accordingly.
In analogue TV, AV1, AV2 modes of the PAL system, you cannot use the Tint(G/R) Function.
In PC mode, you can only make changes to Backlight, Contrast and Brightness.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
The energy consumed during use can be significantly reduced if the brightness level of the picture is lowered, which will 
reduce the overall running cost.

Advanced Settings
Samsung’s new TVs allow you to make even more precise picture settings than previous 
models.

Advanced Settings is available in Standard or Movie mode.
In PC mode, you can only make changes to Dynamic Contrast, Gamma and White 
Balance from among the Advanced Settings items.

Black Tone → Off / Dark / Darker / Darkest
You can select the black level on the screen to adjust the screen depth.

Dynamic Contrast → Off / Low / Medium / High
You can adjust the screen contrast so that the optimal contrast is provided.

Gamma
You can adjust the Primary Colour (Red, Green, Blue) Intensity.
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Mode	 	 : Standard	 	 ►
Backlight		  : 7 
Contrast		  : 95
Brightness		 : 45
Sharpness	 : 50
Colour		  : 50
Tint (G/R)		  : G50/R50
Advanced Settings

Picture

Colour		  : 50
Tint (G/R)		  : G50/R50

Advanced Settings		 	 ►

Picture Options
Picture Reset 

Picture
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Colour Space
Colour Space is a colour matrix composed of red, green and blue colours. Select your favourite Colour Space to experience the 
most natural colour.

Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on programme sources.
Native: Native Colour Space offers deep and rich colour tone.
Custom: Adjusts the colour range to suit your preference.

Customizing the Colour Space
Colour → Red / Green / Blue / Yellow / Cyan / Magenta
Adjusts the Colour range to suit your preference. Colour is available when Colour Space is set to Custom.
Red / Green / Blue: In Colour, you can adjust the RGB values for the selected colour.
Reset: Resets the colour space to the default values.

White Balance
You can adjust the colour temperature for more natural picture colours.

R-Offset / G-Offset / B-Offset / R-Gain / G-Gain / B-Gain: You can adjust the Colour ‘temperature’ in the light areas by 
changing the values of R, G, B, Recommended for advanced users only.
Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone
You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.

Edge Enhancement → Off / On
You can emphasize object boundaries in the picture.

xvYCC → Off / On
Setting the xvYCC mode to on increases detail and colour space when watching movies from an external device (ie. DVD player) 
connected to the HDMI or Component IN jacks.

xvYCC is available when the picture mode is set to Movie, and the external input is set to HDMI or Component mode.
This function may not be supported depending on your external device.

Picture Options
In PC mode, you can only make changes to the Colour Tone and Size from among the items in Picture Options.

Colour Tone → Cool / Normal / Warm1 / Warm2 / Warm3
You can select the most comfortable colour tone to your eyes.

Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Warm1, Warm2 or Warm3 is only activated when the picture mode is Movie.

Size
You can select the picture size which best corresponds to your viewing requirements. 

Press the TOOLS button to display the Tools menu. You can also set the size by selecting Tools → Picture Size.
You can select these options by simply pressing the P.SIZE button on the remote control.
Auto Wide: Automatically adjusts the picture size to the 16:9 aspect ratio. (New Zealand, Singapore only)
16:9: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.
4:3: This is the default setting for a video movie or normal broadcasting.
Screen Fit: Use the function to see the full image without any cutoff when HDMI (720p / 1080i / 1080p) or Component (1080i 
/ 1080p) signals are input.
Depending on the input source, the picture size options may vary.
The items available may differ depending on the selected mode.
In PC Mode, only 16:9 and 4:3 mode can be adjusted.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Temporary image retention may occur when viewing a static image on the set for more than two hours.
Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
screen up / down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the picture 
up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE button. Press 
the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE button.
After selecting Screen Fit in HDMI (1080i / 1080p) or Component (1080i / 1080p) mode: Select Position by pressing the ◄ or 
► button. Use the ▲, ▼, ◄ or ► button to move the picture.
Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.
If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the overscan 
function.
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Screen Mode → 16:9 / Wide Zoom / Zoom / 4:3 (New Zealand, Singapore only)
When setting the picture size to Auto Wide in a 16:9 wide TV, you can determine the picture size you want to see the 4:3 WSS 
(Wide Screen Service) image or nothing. Each individual European country requires different picture size so this function is 
intended for users to select it.

16:9: Sets the picture to 16:9 wide mode.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnify the size of the picture vertically on screen.
4:3: Sets the picture to 4:3 normal mode.

This function is available in Auto Wide mode.
This function is not available in PC, Component or HDMI mode.

Digital NR → Off / Low / Medium / High / Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 
and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.

HDMI Black Level → Normal / Low
You can directly select the black level on the screen to adjust the screen depth.

This function is active only when the external input connects to HDMI (RGB signals).

Film Mode → Off / Auto 1 / Auto 2
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV, COMPONENT(480i / 1080i) and HDMI(480i / 1080i).

100Hz Motion Plus → Off / Clear / Standard / Smooth / Custom / Demo
Removes drag from fast scenes with a lot of movement to provide a clearer picture.

This function is not available in PC mode.
If you enable 100Hz Motion Plus, noise may appear on the screen. If this occurs, set 100Hz Motion Plus to off or select one 
of the other options.
Off: Switches 100Hz Motion Plus off.
Clear: Sets 100Hz Motion Plus to minimum.
Standard: Sets 100Hz Motion Plus to medium.
Smooth: Sets 100Hz Motion Plus to maximum.
Custom: Adjusts the blur and judder reduction level to suit your preference.

Blur Reduction: Adjusts the blur reduction level in video sources.
Judder Reduction: Adjusts the judder reduction level in video sources with film signals.
Reset: Reset the custom settings.

Demo: Displays the difference between 100Hz Motion Plus on and off modes.

Blue Only Mode → Off / On
This function is for AV device measurement experts. This function displays the blue signal only by removing the red and green 
signals from the video signal so as to provide a Blue Filter effect that is used to adjust the Colour and Tint of video equipment such 
as DVD players, Home Theatres, etc. Using this function, you can adjust the Colour and Tint to preferred values appropriate to 
the signal level of each video device using the Red / Green / Blue / Cyan / Magenta / Yellow Colour Bar Patterns, without using an 
additional Blue Filter.

Blue Only Mode is available when the picture mode is set to Movie or Standard.

Picture Reset → Reset Picture Mode / Cancel
Resets all picture settings to the default values.

Reset Picture Mode: Current picture values return to default settings.
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Viewing Picture-in-Picture
You can display a sub picture within the main picture of set programme or video input. In this 
way, you can watch the picture of set programme or video input from any connected equipment 
while watching the main picture.

Press the TOOLS button to display the Tools menu. You can also configure PIP related 
settings by selecting Tools → PIP.
You may notice that the picture in the PIP window becomes slightly unnatural when you 
use the main screen to view a game or karaoke.

PIP

Main picture Sub picture
Component 1, 2
HDMI 1, HDMI2, HDMI3/DVI, HDMI 4
PC

TV, AV1, AV2

PIP → Off / On
You can activate or deactivate the PIP function.

Source
You can select a source of the sub-picture.

You can only set Source by selecting Tools → PIP → Source.

Size → Õ / Ã / À / Œ
You can select a size of the sub-picture.

Position → Ã / – / — / œ
You can select a position of the sub-picture.

In Double (Œ, À) mode, Position cannot be selected.

Channel
You can select the channel for the sub-screen.

Channel is available when the Source is set to TV.

Sound Select → Main / Sub
You can listen to the sound of the sub (PIP) picture.
Press the TOOLS button to display the Tools menu. You can also set the sound of the sub picture by selecting Tools → PIP → 
Sound Select.

Main: Used to listen to the sound of the main picture.
Sub: Used to listen to the sound of the sub picture.

Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)
The Windows display-settings for a typical computer are shown below. The actual screens 
on your PC will probably be different, depending upon your particular version of Windows 
and your particular video card. However, even if your actual screens look different, the 
same basic set-up information will apply in almost all cases. (If not, contact your computer 
manufacturer or Samsung Dealer.)
1.	 First, click on ‘Control Panel’ on the Windows start menu.
2.	 When the control panel window appears, click on ‘Appearance and Themes’ and a 

display dialog-box will appear.
3.	 When the control panel window appears, click on ‘Display’ and a display dialogbox will 

appear.
4.	 Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution): Optimum-1920 X 1080 pixels
If a vertical-frequency option exists on your display settings dialog box, the correct 
value is ‘60’ or ‘60 Hz’. Otherwise, just click ‘OK’ and exit the dialog box.
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Melody	  	 : Medium
Energy Saving 	 : Off

PIP	 	 	 	 	 ►

Setup

PIP
PIP 			   ◄           On            ►
Source			   :	 TV	
Size 			   :	 Õ
Position 			   :	 Ã
Channel			   :	 ATV 1
Sound Select 		  : 	 Main

U Move     L Adjust     R Return
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Display Modes
Both screen position and size will vary depending on the type of PC monitor and its resolution. The resolutions in the table are 
recommended.

D-Sub and HDMI/DVI Input

Mode Resolution Horizontal Frequency 
(KHz)

Vertical Frequency 
(Hz)

Pixel Clock Frequency 
(MHz)

Sync Polarity 
(H / V)

IBM 640 x 350 31.469 70.086 25.175 +/-
720 x 400 31.469 70.087 28.322 -/+

MAC
640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT

720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 960 75.231 74.857 130.000 -/+
1280 x 720 56.456 74.777 95.750 -/+

VESA DMT

640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+ 
1280 x 800 62.795 74.934 106.500 -/+ 
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+
1440 x 900 70.635 74.984 136.750 -/+

1680 x 1050 65.290 59.954 146.250 -/+
VESA GTF 1280 x 720 52.500 70.000 89.040 -/+ 

1280 x 1024 74.620 70.000 128.943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN 3(DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.
Too long or low quality VGA cable can cause picture noise at high resolution modes (1920x1080 or 1600x1200).

Setting up the TV with your PC
Preset: Press the SOURCE button to select PC mode.

Auto Adjustment
Auto Adjustment allows the PC screen of set to self-adjust to the incoming PC video signal. 
The values of fine, coarse and position are adjusted automatically.

Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 
by selecting Tools → Auto Adjustment.
This function does not work in DVI-HDMI mode.

Screen

Coarse / Fine
The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is not removed by Fine-tuning alone, 
then adjust the frequency as best as possible (Coarse) and Fine-tune again. After the noise has been reduced, readjust the picture 
so that it is aligned on the center of screen.

PC Position
Adjust the PC’s screen positioning if it does not fit the TV screen. Press the ▲ or ▼ button to adjusting the Vertical-Position. Press 
the ◄ or ► button to adjust the Horizontal-Position.

Image Reset
You can replace all image settings with the factory default values.
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Brightness			  : 45 
Sharpness		  : 50

Auto Adjustment	 	 	 ►

Screen	
Advanced Settings	
Picture Options	  
Picture Reset

Picture
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SOUND CONTROL

Configuring the Sound Menu

Mode → Standard / Music / Movie / Clear Voice / Custom
You can select a sound mode to suit your personal preferences.

Press the TOOLS button to display the Tools menu. You can also configure the sound 
mode by selecting Tools → Sound Mode.

Equalizer
The sound settings can be adjusted to suit your personal preferences.

Mode
You can select a sound mode to suit your personal preferences.

Balance
Controls the balance between the right and left speakers.

100Hz / 300Hz / 1KHz / 3KHz / 10KHz (Bandwidth Adjustment)
To adjust the level of different bandwidth frequencies

Reset
Resets the equalizer settings to the default values.

SRS TruSurround HD → Off / On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 
speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 
including internal television speakers. It is fully compatible with all multichannel formats.

Press the TOOLS button to display the Tools menu. You can also set the SRS TruSurround HD by selecting Tools → SRS TS 
HD.

Audio Language (digital channels only)
You can change the default value for audio languages. Displays the language information for the incoming stream.

While viewing a digital channel, this function can be selected.
You can only select the language among the actual languages being broadcast.

Audio Format → MPEG / Dolby Digital / Advanced (digital channels only)
When sound is emitted from both the main speaker and the audio receiver, a sound echo may occur due to the decoding speed 
difference between the main speaker and the audio receiver. In this case, use the TV Speaker function.

While viewing a digital channel, this function can be selected.
The Audio Format appears according to the broadcasting signal.

Audio Description (digital channels only)
This is an auxiliary audio function that provides an additional audio track for visually challenged persons. This function handles the 
Audio Stream for the AD (Audio Description), when it is sent along with the Main audio from the broadcaster. Users can turn the 
Audio Description On or Off and control the volume.

Audio Description → Off / On
Turn the audio description function on or off.

Volume
You can adjust the audio description volume.

Volume is active when Audio Description is set to On.
While viewing a Digital channel, this function can be selected.

Auto Volume → Off / On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 
changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 
modulation signal is high or by raising the sound output when the modulation signal is low.
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Speaker Select → External Speaker / TV Speaker
If you want to hear the sound through separate speakers, cancel the internal amplifier.

The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.
If you select External Speaker in the Speaker Select menu, the sound settings will be limited.

TV’s Internal Speakers Audio Out (Optical, L/R Out) to Sound System
RF, AV, Component, PC, HDMI RF, AV, Component, PC, HDMI

TV Speaker Sound Output Sound Output
External Speaker Mute Sound Output
Video No Signal Mute Mute

Sound Select
When the PIP feature is activated, you can listen to the sound of the sub (PIP) picture.

For detailed procedures on setting up options, refer to page 16.

Sound Reset → Reset All / Reset Sound Mode / Cancel
You can restore the Sound settings to the factory defaults.

Reset Sound Mode: Current sound values return to default settings.

Selecting the Sound Mode
You can set the sound mode in the Tools menu. When you set to Dual l ll, the current sound mode is displayed on the screen.

Audio Type Dual 1 / 2 Default

A2 Stereo
Mono MONO

Automatic change
Stereo STEREO ↔ MONO
Dual DUAL 1 ↔ DUAL 2 DUAL 1

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO ↔ STEREO

Dual MONO ↔ DUAL 1
DUAL 2 DUAL 1

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound signal.
This function is only available in TV mode.
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SETUP

Configuring the Setup Menu

Time

Clock
Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.
If you disconnect the power cord, you have to set the clock again.
Clock Mode
You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time from the digital broadcast.
Manual: Set the current time to a manually specified time.

Clock Set
You can set the current time manually.

You can set the day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Time Zone (Australia only)
You can select your time zone.

Set up this item when you have set Clock Mode to Auto.

Sleep Timer → Off / 30 / 60 / 90 / 120 / 150 / 180
The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 minutes).

The TV automatically switches to standby mode when the timer reaches 0.
To cancel the Sleep Timer function, select Off.
Press the TOOLS button to display the Tools menu. You can also set the sleep timer by selecting Tools → Sleep Timer.

Timer 1 / Timer 2 / Timer 3
Three different on / off timer settings can be made. You must set the clock first.

On Time: Set the hour, minute, and activate / inactivate. (To activate timer with the setting you’ve chosen, set to Activate.)
Off Time: Set the hour, minute, and activate / inactivate. (To activate timer with the setting you’ve chosen, set to Activate.)
Volume: Select the desired turn on volume level.
Source → TV / USB / TV Memory
You can select the TV, TV Memory or USB device content to be played when the TV turns on automatically. Select TV, TV 
Memory or USB. (Make sure that an USB device is connected to your TV.)

When there is only one photo file in the USB or the TV memory, Slide Show will not be executed.
Antenna (when Source is set to TV)
Select ATV or DTV.
Channel (when Source is set to TV)
Select the desired channel.
Contents (when Source is set to USB or TV Memory)
You can select a folder on the USB Device/TV Memory with the music or photo files to be played when the TV turns on 
automatically.
Repeat: Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or Manual.

When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 
desired day and the c mark will appear.

You can set the hour, minute and channel by pressing the number buttons on the remote control.
Auto Power Off
When you set the timer On, the television will eventually turn off, if no controls are operated for 3 hours after the TV was 
turned on by the timer. This function is only available in timer On mode and prevents overheating, which may occur if a TV is 
on for too long time.
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Plug & Play	

Time	 	 	 	 	 ►

Game Mode		  : Off
BD Wise			   : On	
Network Type
Network Setup
Child Lock 		  : On
Change PIN
Parental Lock

Setup
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Game Mode → Off / On
When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more realistic gaming experience by 
selecting game menu.

Restrictions on game mode (Caution)
To disconnect the game console and connect another external device, set Game Mode to Off in the setup menu.
If you display the TV menu in Game mode, the screen shakes slightly.

Game Mode is not available in TV and PC mode.
While PIP is in operation, the Game Mode function cannot be used.
If the picture is poor when external device is connected to TV, check if Game Mode is On. Set Game Mode to Off and 
connect external devices.
If Game Mode is On:

Picture Mode changes to Standard and Sound Mode changes to Custom automatically. The user cannot change these to 
other modes.
Sound Mode in the Sound menu is deactivated. Adjust the sound using the equalizer.

The Reset Sound function is activated. Selecting the Reset function after setting the equalizer resets the equalizer setting to 
the factory defaults.

BD Wise → Off / On
Provides the optimal picture quality for SAMSUNG DVD, BD and HTS products which support WISESYNC. You can enjoy a richer 
picture when using them connected to the TV.

Connect SAMSUNG products which support the TV and BD Wise using a HDMI cable.
When the BD Wise set to On, the picture mode is automatically changed to the optimal resolution.
BD Wise is available in HDMI mode.

Network Type / Network Setup
For detailed procedures on setting up options, refer to the descriptions on pages 26~28.

Child Lock → Off / On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 
and audio.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.
You can lock some channels in Channel List. (refer to page 11)
Child Lock is available only in TV mode.

Change PIN
You can change your personal ID number that is required to set up the TV.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0.
If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to 0-0-0-0: 
POWER (Off) → MUTE → 8 → 2 → 4 → POWER (On).

Parental Lock
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by a 4-digit PIN 
(Personal Identification Number) code that is defined by the user.

The Parental Rating item differs depending on the country.
Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.
When the parental ratings are set, the \ symbol is displayed.
Allow All: Press to unlock all TV ratings.
Block All: Press to lock all TV ratings.
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Subtitle
You can activate and deactivate the subtitles. Use this menu to set the Subtitle Mode. Normal under the menu is the basic subtitle 
and Hard of hearing is the subtitle for a hearing-impaired person.

Subtitle → Off / On
Switches subtitles on or off.

Mode → Normal / Hard of hearing
Sets the subtitle mode.

Subtitle Language
Set the subtitle language.

If the programme you are watching does not support the Hard of hearing function, Normal automatically activates even 
though Hard of hearing mode is selected.
English is the default in cases where the selected language is unavailable in the broadcast.
You can select these options simply by pressing the SUBT. button on the remote control.

Teletext Language
You can set the Teletext language by selecting the language type.

English is the default in cases where the selected language is unavailable in the broadcast.

Preference

Primary Audio Language / Secondary Audio Language / Primary Subtitle Language / Secondary Subtitle Language / 
Primary Teletext Language / Secondary Teletext Language
Using this feature, users can select one of the languages. The language selected here is the default when the user selects a 
channel.
If you change the language setting, the Subtitle Language, Audio Language, and the Teletext Language of the Language menu are 
automatically changed to the selected language.
The Subtitle Language, Audio Language, and the Teletext Language of the Language menu show a list of languages supported 
by the current channel and the selection is highlighted. If you change this language setting, the new selection is only valid for the 
current channel. The changed setting does not change the setting of the Primary Subtitle Language, Primary Audio Language, or 
the Primary Teletext Language of the Preference menu.

Digital Text → Disable / Enable (New Zealand only)
If the programme is broadcast with digital text, this feature is enabled.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
An International standard for data encoding systems used in multimedia and hypermedia. This is at a higher level than
the MPEG system which includes data-linking hypermedia such as still images, character service, animation, graphic and
video files as well as multimedia data. MHEG is user runtime interaction technology and is being applied to various fields
including VOD (Video-On-Demand), ITV (Interactive TV), EC (Electronic Commerce), tele-education, tele-conferencing,
digital libraries and network games.
At present, the broadcasting station provides EPG content only. Providing more content is scheduled for the future.
If Digital Text is set to Disable, the EPG (Electronic Program Guide) will not work.

Melody → Off / Low / Medium / High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play
When no sound is output from the TV because the MUTE button has been pressed.
When no sound is output from the TV because the (–) Volume button has been pressed.
When the TV is turned off by Sleep Timer function.

Energy Saving → Off / Low / Medium / High / Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 
Saving mode option to High to reduce eye fatigue as well as power consumption.

Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools → Energy 
Saving.

PIP
For further details on setting up options, refer to page 16.
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Network Connection
You can set up the Internet Protocol so that you can communicate with various connected networks.

Network Connection - Cable

LAN Connection for a DHCP Environment
The procedures to set up the network using Dynamic Host Configuration Protocol (DHCP) are described below. Since an IP 
address, subnet mask, gateway, and DNS are automatically allocated when DHCP is selected, you do not have to enter them 
manually.
1.	 Connect the LAN port on the rear panel of the TV and the external modem with a LAN Cable.
2.	 Connect the Modem port on the wall and the external modem with a Modem Cable.

You can connect the LAN via a Sharer (Router).

You can connect the LAN port and the TV directly depending on your network status.

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.
If the IP address allocation by the DHCP server has failed, turn the external modem off, turn it on again after at least 10 
seconds and then try again.
For the connections between the external modem and the Sharer (Router), refer to the owner’s manual of the corresponding 
product.
You can connect the TV to the LAN directly without connecting it through a Sharer (Router)
You cannot use a manual-connection-type ADSL modem because it does not support DHCP. You have to use an automatic-
connection-type ADSL modem.
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The Modem Port on the Wall External Modem 

(ADSL / VDSL / Cable TV)

1 LAN Cable2 Modem Cable

TV Rear PanelThe Modem Port on the Wall
External Modem 

(ADSL / VDSL / Cable TV)

LAN CableModem Cable LAN Cable

IP Sharer

TV Rear PanelThe LAN Port on the Wall

LAN Cable
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LAN Connection for Static IP Environment
The procedures to set up the network using a static IP address are described below. You have to manually enter the IP address, 
subnet mask, gateway, and DNS that are provided by your Internet Service Provider (ISP). 
1.	 Connect the LAN port on the rear panel of the TV and the LAN port on the wall using the LAN cable.

You can connect the LAN via a Sharer (Router).

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.
If you are using a static IP address, your ISP will inform you of the IP address, subnet mask, gateway, and DNS. You must 
enter these values to complete the network settings. If you do not know the values, ask your network administrator.
For the information on how to configure and connect a Sharer (Router), refer to the owner’s manual for the corresponding 
product.
You can connect the TV to the LAN directly without connecting it through a Sharer (Router).
If you use an IP Sharer (IP Router) that supports DHCP, you can set up the device as either DHCP or static IP.
For the procedures to use a static IP address, ask your Internet Service Provider.
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Network Connection - Wireless
You can connect to the network wirelessly through a wireless IP sharer.

1.	 Connect the ‘Samsung Wireless LAN Adapter’ into the USB1(HDD) or USB2 terminal of the TV.
You must use the ‘Samsung Wireless LAN Adapter’(WIS09ABGN) to use a wireless network.
Samsung’s Wireless LAN adapter is sold separately. The WIS09ABGN Wireless LAN adapter is offered by select retailers, 
Ecommerce sites and Samsungparts.com.
To use a wireless network, your TV must be connected to a wireless IP sharer. If the wireless IP sharer supports DHCP, 
your TV can use a DHCP or static IP address to connect to the wireless network.
Samsung’s Wireless LAN adapter supports IEEE 802.11A, IEEE 802.11B, IEEE 802.11G, IEEE 802.11N. When you play 
DLNA video over IEEE 802.11B/G connection, the video may not be played smoothly.
If the wireless IP sharer allows you to turn the Ping connection function on/off, turn it on.
Select a channel for the wireless IP sharer that is not currently being used. If the channel set for the wireless IP sharer is 
currently being used by another device nearby, this will result in interference and communications may fail.
If you apply a security system other than the systems listed blow, it will not work with the TV. 

When applying the security key for the AP (wireless IP sharer), only the following is supported.
1) Authentication Mode : OPEN, SHARED, WPAPSK, WPA2PSK
2) Encryption Type : WEP, TKIP, AES
When applying the security key for the Ad-hoc mode, only the following is supported.
1) Authentication Mode : SHARED, WPANONE
2) Encryption Type : WEP, TKIP, AES

If your AP supports WPS(Wi-Fi Protected Setup), you can connect to the network via PBC (Push Button Configuration) or 
PIN (Personal Indentification Number). WPS will automatically configure the SSID and WPA key in either mode.
If the device isn’t certified, it may not connect to the TV via the ‘Samsung Wireless LAN Adapter’.
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Setting the Network

Network Type
Select Cable or Wireless as the method to connect to the network.

The menu is activated only if the ‘Samsung Wireless LAN Adapter’ is connected. 

Cable
Connect to the network using a cable.

Wireless
Connect to the network wirelessly.

Network Setup 

Cable Network Setup (when Network Type is set to Cable)
Please check if the LAN cable is connected.
Internet Protocol Setup → Auto / Manual
Network Test: You can test or confirm the network connection status after setting up the network.
When unable to connect to a wired network
If your Internet service provider has registered the MAC address of the device used to connect to the Internet for the first time 
and authenticates the MAC address each time you connect to the Internet, your TV may not be able to connect to the Internet 
as the MAC address differs from that of the device (PC).
In this case, ask your Internet service provider about the procedures to connect devices other than your PC (such as your TV) 
to the Internet. If your Internet service provider requires an ID or password to connect to the Internet (network), your TV may 
not be able to connect to the Internet. In this case, you have to enter your ID or password when connecting to the Internet 
using an Internet Sharer (Router).
The internet connection may fail due to a firewall problem. In this case, contact your Internet service provider. If you cannot 
connect to the Internet even if you have followed the procedures of your Internet service provider, please contact Samsung 
Electronics.

Cable Network Setup-Auto
If you connect the LAN cable and it supports DHCP, the Internet Protocol (IP) Settings are 
automatically configured. 
1.	 Set Network Type to Cable.

2.	 Select Cable Network Setup.
3.	 Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.
4.	 Select Network Test to check the network connectivity.

Cable Network Setup-Manual 
To connect the TV to the LAN using a static IP address, you must set up the Internet Protocol 
(IP). 
1.	 Set Network Type to Cable.
2.	 Select Cable Network Setup.
3.	 Set Internet Protocol Setup to Manual.
4.	 Set up IP Address, Subnet Mask, Gateway and DNS Server.

Press the number buttons on the remote control when you set the Network manually.
5.	 Select Network Test to check the network connectivity.

Wireless Network Setup (when Network Type is set to Wireless)
The menu is activated only if the ‘Samsung Wireless LAN Adapter’ is connected.
Internet Protocol Setup → Auto / Manual
Network Test: You can test or confirm the network connection status after setting up the network.
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Internet Protocol Setup	 : Auto	 	 ▶
Network Test

U Move     E Enter     R Return

Cable Network Setup

IP Address	 :            
Subnet Mask	 :            
Gateway	 :             	
DNS Server	 :            

Internet Protocol Setup	 : Manual	 	 ▶
Network Test

U Move     E Enter     R Return

Cable Network Setup

IP Address	 : 0    0    0    0

Subnet Mask	 : 0    0    0    0

Gateway	 : 0    0    0    0	
DNS Server	 : 0    0    0    0

Game Mode	 : Off
BD Wise	 : On

Network Type	 : Cable	 ▶

Network Setup
Child Lock	 : On
Change PIN
Parental Lock
Subtitle
Teletext Language	 : - - -
Preference

Setup
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When unable to connect to an AP(Access Point)
Your TV may fail to locate an AP(Access Point) that is configured as a private SSID type. In this case, please change the AP 
settings and try again. If your Internet service provider has registered the MAC address of the device used to connect to the 
Internet for the first time and authenticates the MAC address each time you connect to the Internet, your TV may not be able 
to connect to the Internet as the MAC address differs from that of the device (PC).
In this case, ask your Internet service provider about the procedures to connect devices other than your PC (such as your TV) 
to the Internet. If you cannot connect to the Internet even if you have followed the procedures of your Internet service provider, 
please contact a Samsung Electronics.
Select a network

Access Point: You can select the IP sharer to use when using a wireless network.
If a wireless Access Point is not in the Access Point list, press the Red button.
When the connection is made, you will be returned to the screen automatically.
If you have selected an Access Point with a security authentication:
The Security Key input screen appears. Enter the security key and press the 
Blue button on the remote control.
If security encryption type is WEP, 0~9, A~F will be available when you input 
security key.

Connecting WPS (Wi-Fi Protected Setup)
If Security Key is already set: In access point list, select WPS.

You can select PBC, PIN, Security Key.

Connecting by using PBC: Select a PBC (Push Button Configuration). Press the PBC 
button on the AP (access point) within 2minutes, and wait for connection.

Connecting by using PIN: Select a PIN (Personal Identification Number). 
The message showing the PIN Code is displayed. Input the PIN Code at AP 
device within 2minutes. Select OK and wait for connection.
Try again if connecting operation doesn’t work
When the connection is not established although tried again, reset the access point. Please refer to a manual of each 
access point.

Connecting by using Security Key: When selecting Security Key, the input window is 
displayed. Input the security key and press Blue button.

Try again if connecting operation doesn’t work.

If Security Key is not set: When the security setting of AP that supports WPS is NONE, 
you can select PBC, PIN, None Security. None Security is capable of connecting to AP 
directly without using WPS function.

Process of PBC, PIN is same as above. Refer to if Security Key is already set.
Try again if connecting operation doesn’t work.
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Ad-hoc: You can connect to a mobile device without an access point through the ‘Samsung Wireless LAN Adapter’ by 
using a peer to peer network.

How to connect to new Ad-hoc
1.	 Choose Select a network, then a device list is displayed.
2.	 While in the device list, press the Blue button on the remote or select Ad-

hoc.
The message The existing network system may have limited 
functionality. Do you want to change the network connection? is 
displayed.

3.	 Input the generated Network Name(SSID) and Security Key into the 
device you want to connect.  

N

How to connect an existing Ad-hoc device
1.	 Choose Select a network, the device list is displayed.
2.	 Select the device you want in the Device list.
3.	 If security key was applied, input the security key again.

If network doesn’t operate normally, please check the Network 
Name(SSID) and Security Key again. If the Security Key is incorrect, 
it may be the reason for the malfunction.

N

Wireless Network Setup-Auto
If you want to connect AP, AP should support DHCP. Only devices which support Ad-hoc mode 
can be connected without DHCP.
1.	 Set Network Type to Wireless.
2.	 Select Wireless Network Setup.
3.	 Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.
4.	 Select a network through Select a network.
5.	 Select Network Test to check the network connectivity.

Wireless Network Setup-Manual
1.	 Set Network Type to Wireless.
2.	 Select Wireless Network Setup.
3.	 Set Internet Protocol Setup to Manual.
4.	 Set up IP Address, Subnet Mask, Gateway and DNS Server.

Press the number buttons on the remote control when you set the Network manually.
5.	 Select a network through Select a network.
6.	 Select Network Test to check the network connectivity.
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Internet Protocol Setup	 : Auto	 	 ▶
Network Test
Select a network 	 : AP1

U Move     E Enter     R Return

Wireless Network Setup

IP Address	 :            
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Wireless Network Setup

IP Address	 : 0    0    0    0

Subnet Mask	 : 0    0    0    0
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The existing network system may have limited 
functionality. Do you want to change the network 
connection?
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INPUT / SUPPORT

Configuring the Input Menu

Source List
Use to select TV or other external input sources such as DVD / Blu-ray players / Satellite 
receivers (Set-Top Box) connected to the TV. Use to select the input source of your choice.

Press the SOURCE button on the remote control to view an external signal source. TV 
mode can be selected by pressing the TV button.

TV / AV1 / AV2 / Component1 / Component2 / PC / HDMI1 / HDMI2 / HDMI3/DVI / HDMI4 / 
USB

You can choose only those external devices that are connected to the TV. In the Source 
List, connected inputs will be highlighted and sorted to the top. Inputs that are not 
connected will be sorted to the bottom.
If USB devices are connected to the USB1(HDD) and USB2 jacks, they are displayed as USB1 and USB2 in order.
PC always stay activated.
Using the Colour buttons on the remote with the Source list

Red (Refresh): Refreshes the connecting external devices.
TOOLS (Tools): Displays the Edit Name and Information menus.

Edit Name
Name the device connected to the input jacks to make your input source selection easier.

VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI / DVI PC / TV / IPTV / Blu-ray 
/ HD DVD / DMA

When a PC with a resolution of 1920 x 1080@60Hz is connected to the HDMI IN 3(DVI) port, you should set the HDMI3/DVI 
mode to DVI PC in the Edit Name of the Input mode.
When connecting an HDMI/DVI cable to the HDMI IN 3(DVI) port, you should set the HDMI3/DVI mode to DVI or DVI PC in 
the Edit Name of the Input mode. In this case, a separate sound connection is required.

Configuring the Support Menu

Product Guide
The Product Guide gives you information on the most important features of this TV.
The descriptions provided by this function are in English only.

Self Diagnosis

Picture Test
If you think you have a picture problem, perform the picture test. Check the colour pattern on 
the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 
There may be a problem with the TV. Contact Samsung’s call center for assistance.
No: If the test pattern is properly displayed, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual.
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Sound Test
If you think you have a sound problem, please perform the sound test. You can check the sound by playing a built-in melody sound 
through the TV.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure Speaker Select is set to TV 
speaker in the Sound menu.
The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 
the MUTE button.
Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 
the TV. Contact Samsung’s call center for assistance.
No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual. 

Signal Information (digital channels only)
Unlike analogue channels, which can vary in reception quality from ‘snowy’ to clear, digital (HDTV) channels have either perfect 
reception quality or you will not receive them at all. So, unlike analogue channels, you cannot fine tune a digital channel. You can, 
however, adjust your antenna to improve the reception of available digital channels.

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to increase the signal strength. 
Continue to adjust the antenna until you find the best position with the strongest signal.

Software Upgrade
To keep your product up-to-date with new Digital Television features then software upgrades 
are periodically broadcast as part of the normal Television signal. It will automatically detect 
these signals and display the software upgrade banner. You are given the option to install the 
upgrade.

Current Version shows version of the software being installed in the TV.
Alternative Software shows the previous version that can be replaced.
Software is represented as ‘Year/Month/Day_Version’. The more recent the date, the 
newer the software version. Installing the latest version is recommended.

By USB
Insert a USB drive containing the firmware upgrade into TV. Please be careful to not 
disconnect the power or remove the USB drive while upgrades are being applied. The TV 
will turn off and turn on automatically after completing the firmware upgrade. Please check 
the firmware version after the upgrades are complete. When software is upgraded, video and 
audio settings you have made will return to their default (factory) settings.
We recommend you write down your settings so that you can easily reset them after the 
upgrade.

By Channel
Upgrades the software using the broadcasting signal.

If the function is selected during the software transmission period, this function searches for available software and downloads 
the software.
The time required to download the software is determined by the signal status. 

Standby Mode Upgrade
To continue software upgrade with master power on, Select On by pressing the ▲ or ▼ button. 45 minutes after entering standby 
mode, a manual upgrade is automatically conducted. Since the power of the unit is turned on internally, the screen may be on 
slightly for the LCD product. This phenomenon may continue for more than 1 hour until the software upgrade is completed.

Alternative Software
If Alternative Software is existing, this menu will be activated. You can change the software to previous version.

If software was changed, existing software is displayed.
You can change current software to alternative software by ‘Alternative Software’.

HD Connection Guide
This menu presents the connection method that provides the optimal quality for the HD TV.
Refer to this information when connecting external devices to the TV.

Contact Samsung
View this information when your TV does not work properly or when you want to upgrade the software.
You can view the information regarding the call center, product and software file download method.
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Current Version		  2009/01/16_000001
Software Upgrade

By USB
BY Channel
Standby Mode Upgrade
Alternative Software	 2009/01/15_000000
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Media Play (USB & DLNA)

Connecting a USB Device
1.	 Press the POWER button to turn the TV on.
2.	 Connect a USB device containing photo, music and/or movie files to the USB1(HDD) or 

USB2 jack on the side of the TV.
3.	 When the Application selection screen is displayed, press the ENTERE button to select 

Media Play (USB & DLNA).
MTP (Media Transfer Protocol) is not supported.
The file system supports FAT16, FAT32 and NTFS.
Certain types of USB Digital camera and audio devices may not be compatible with 
this TV.
Media Play only supports USB Mass Storage Class devices (MSC). MSC is a Mass Storage Class Bulk-Only Transport 
device. Examples of MSC are Thumb drives, Flash Card Readers and USB HDD (USB HUB are not supported.). 
Please connect directly to the USB port of your TV. If you are using a separate cable connection, there may be a USB 
compatibility problem.
Before connecting your device to the TV, please back up your files to prevent them from damage or loss of data. 
SAMSUNG is not responsible for any data file damage or data loss.
Connect a USB HDD to the dedicated port, USB1 (HDD) port. However, if the connected device requires high power, the 
USB1 (HDD) may fail to support the device.
Do not disconnect the USB device while it is loading.
MSC supports MP3 and JPEG files, while a PTP device supports JPEG files only.
The higher the resolution of the image, the longer it takes to display on the screen.
The maximum supported JPEG resolution is 15360X8640 pixels. 
For unsupported or corrupted files, the ‘Not Supported File Format’ message is displayed.
If sort key is set to Basic View, up to 1000 files can be displayed in each folder. The other sort key can display up to 10000 
files.
MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights Management (DRM) 
is a technology that supports the creation of content, the distribution and management of the content in an integrated 
and comprehensive way, including the protection of the rights and interests of the content providers, the prevention of the 
illegal copying of contents, as well as managing billings and settlements.
When moving to a photo, loading may take a few seconds. At this point, the loading icon will appear at the screen. 
If more than 2 PTP devices are connected, you can only use one at a time. 
If more than one MSC device is connected, some of them may not be recognized. If a device requires high power (more 
than 500mA or 5V), the USB device may not be supported. 
If a over-power(Fail add new device USB1/USB2 Power Overload) warning message is displayed while you connecting or 
using a USB device, the device may not be recognized or may malfunction.

Using the Remote Control Button in Media Play Menu

Button Operations
▲/▼/◄/► Move the cursor and select an item.

ENTERE
Select the currently selected item. While playing a slide show, movie, or music file:
- Pressing the ENTERE button during play pauses the play.
- Pressing the ENTERE button during pause resumes the play.

∂/∑ Play or pause the Slide Show, music or movie.
RETURN Return to the previous menu.
TOOLS Run various functions from the Photo, Music and Movie menus.

∫ Stop the current slide show, Music or Movie file.
π/μ Show file information.

INFO Show file information.
MEDIA.P Exit Media Play mode.

< P >, EXIT, TV Stop Media Play mode and Returns to TV mode.
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Media Play Function
This function enables you to view and listen to photo, music and/or movie files saved on a USB Mass Storage Class (MSC) device.

It might not work properly with unlicensed multimedia files.

Entering the Media Play (USB & DLNA) Menu

1.	 Press the MENU button. Press the ▲ or ▼ button to select Application, then press the 
ENTERE button.

2.	 Press the ▲ or ▼ button to select Media Play (USB & DLNA), then press the ENTERE 
button.

The Media Play (USB & DLNA) menu is displayed.
Press the MEDIA.P button on the remote control to display the Media Play menu.
Press the SOURCE button on the remote control to view the source list. Then Press 
the ▲ or ▼ button to select USB.

3.	 Press the Red button, then press the ▲ or ▼ button to select the TV memory or USB 
Memory. Press the ENTERE button.

This function differs depending on the TV Memory / USB Memory Device / DLNA server.
The selected USB device name appears at the bottom left of the screen.

4.	 Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then press the ENTERE button. 
To exit Media Play mode, press the MEDIA.P button on the remote control.

Removing a USB Memory Device Safely
You can remove the device safely from the TV.
1.	 Press the TOOLS button in the Media Play file list screen, or while a Slide Show, music or movie is being played.
2.	 Press the ▲ or ▼ button to select Remove Safely, then press the ENTERE button.
3.	 Remove the USB device from the TV.

Screen Display

Move to either ‘Sort key List Section’, ‘Group List Section’ or ‘File List Section’ using the Up and Down buttons. After selecting a 
section, press the ◄ or ► buttons to select an item.
1	 Current Sort key: This field shows the current standard for sorting files. Press the ◄ or ► button to change the standard for 

sorting files.
2	 View Groups: Shows the detailed groups of the files sorted according the selected Sort key. The sort group where the currently 

selected file is contained is highlighted.
3	 Currently selected file: The selected file is the file you can now control. Photo and movie files are displayed as thumbnail 

images.
4	 Current Device: Shows the currently selected device name. Press the Red button to select a device.

Red (Device) button: Selects a connected device.
5	 Item Selection Information: Shows the number of files that are selected by pressing the Yellow button.
6	 Help Items

Green (Favourites Setting) button: Changes the Favourites Setting for the selected file. Press this button repeatedly until 
the desired value appears.
Yellow (Select) button: Selects file from the file list. Selected files are marked with a symbol c. Press the yellow button 
again to cancel a file selection.
TOOLS (Tools) button: Displays the option menus. (The option menu changes according to the current status.)
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Sorting the Photo List
You can sort photos in the Photo List by a particular standard.
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Photo, then press the ENTERE button. 
3.	 Press the ▲ button to move to the Sort key Section.
4.	 Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 

Colour, Folder, Preference)
The photos are sorted according to the newly selected sorting standard.

5. 	 Press the ▼ button to move to the File List Section. Press the ∂ (Play)/
ENTERE button to start the Slide Show in the order you selected.

To move to the previous/next group, press the π (REW) or μ (FF) button.
Photo information is automatically set. The colour information extracted from a 
photo file may be different from your expectations. You can change the colour 
and preference.
PTP does not support folder sort mode.

Basic View
Shows the folders on the USB memory device. If you select a folder and press the 
ENTERE button, only the photo files contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Timeline
Sorts photos by date. It sorts by year and month from the earliest photo.

Colour → Red / Yellow / Green / Blue / Magenta / Black / Gray / Unclassified
Sorts photos by colour. You can change the photo colour information.

You should set the Use Colour View to on in the Setup menu before sorting photos by colour.

Folder
Sorts photos by folder. If there are many folders in USB, the photos files are shown in order in each folder. The photo file in the 
Root folder is shown first and the others are shown in alphabetical order by name.

Preference → FFF / FFF / FFF / FFF
Sorts photos by preference (Favourites). You can change the photo preferences.

Changing the Favourites Setting
Select the desired photo in the Photo list, then press the Green button repeatedly until the desired setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.
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Photo List Option Menu
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Photo, then press the ENTERE button. 
3.	 Press the ◄ or ► button to select the desired photo file.

Selecting Multiple Photos
Press the ◄ or ► button to select the desired photo file. Then press the Yellow button.
Repeat the above operation to select multiple photo files.
The mark c appears to the selected photo file.

4.	 Press the TOOLS button.
The option menu changes according to the current status.

Slide Show
Using this menu, you can play a SlideShow using the photo files on the USB memory 
device.

Copy / Copy Current Group / Copy the selected file (When multiple files 
are selected)
Select a photo you want to copy. (Alternatively, select multiple files by pressing the 
Yellow button.) Press the TOOLS button to select Copy (or Copy Current Group / 
Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 
When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)
Select a photo to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 
Delete (or Delete All / Delete Selected File). The files are deleted. 

You can only delete the files saved in the TV memory.
You cannot recover a deleted file. 

Play Current Group
Using this menu, you can play a SlideShow using only the photo files in the currently selected sorting group.

Change Group (When the Sort key is the Colour)
You can change a selected photo file’s (or group of files) colour information in order to move it from one colour group to another.

This does not change the actual colour of the photo.
The group information of the current file is updated and the photos are moved to the new colour group.
To change the information of multiple files, select the files you want by pressing the Yellow button.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The photo file information including the name, the size, the resolution, the date modified and the path is displayed.

You can view the information of photo files during a SlideShow using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Viewing a Photo or Slide Show

Viewing a Slide Show

1.	 Press the ▼ button to select the File List Section.
2.	 Press the TOOLS button.
3.	 Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

All files in the File List Section will be used for the Slide Show.
During the slide show, files are displayed in order from the currently shown 
file.
The Slide Show progresses in the order sorted in the File List Section.
Music files can be automatically played during the Slide Show if the 
Background Music is set to On. 

While a photo list is displayed, press the ∂(Play)/ENTERE button on the remote control to start slide show.
SlideShow Control Buttons

Button Operations
ENTERE Play/Pause the Slide Show.

∂ Play the Slide Show.
∑ Pause the Slide Show.
∫ Exit Slide Show and return to the photo list.

π/μ Change the SlideShow playing speed.
TOOLS Run various functions from the Photo menus.

Playing current group

1.	 Press the ▲ button to move to the Sort key Section.
2.	 Press the ◄ or ► button to select a sorting standard. 
3.	 Press the ▼ button to move to the Group List Section.
4.	 Select a group using the ◄ and ► buttons.
5.	 Press the ∂ (Play) button. A slideshow begins with the files of the selected group.

Alternatively 
1.	 Select a Sort key and then in the File List Section, select the photos contained in the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) button.
2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

Only the photos in the sorting group including the selected files will be used for the Slide Show.

To perform a Slide Show with only the selected files

1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select the desired photo in the  File List Section.
3.	 Press the Yellow button.
4.	 Repeat the above operation to select multiple photos.

The c mark appears to the left of the selected photo.
If you select one file, the Slide Show will not be performed.
To deselect all selected files, press the TOOLS button and select Deselect All.

5.	 Press the ∂ (Play)/ENTERE button.
The selected files will be used for the Slide Show.

Alternatively 
1.	 In the File List Section, press the Yellow buttons to select the desired photos.
2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

The selected files will be used for the Slide Show.
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Slide Show Option Menu
1.	 During a slide show (or viewing a photo), press the TOOLS button to set the 

option.
2.	 Press the ▲ or ▼ button to select the desired option, then press the ENTERE 

button.

Stop Slide Show / Start Slide Show
You can start or stop a SlideShow.

Slide Show Speed → Slow / Normal / Fast
You can select the slide show speed.

This function is available only during a slide show.
You can also change the speed of the Slide Show by pressing the π (REW) or μ (FF) button during the Slide Show.

Slide Show Effect
You can select the screen transition effect used in the slideshow.

None / Fade1 / Fade2 / Blind / Spiral / Checker / Linear / Stairs / Wipe / Random
This function is available only during a slide show.

Rotate
You can rotate photos saved on a USB memory device.

Whenever you press the ◄ button, it rotates by 270˚, 180˚, 90˚, and 0˚.
Whenever you press the ► button, it rotates by 90˚, 180˚, 270˚, and 0˚. 
The rotated file is not saved.

Zoom
You can magnify photos saved on a USB memory device. (x1 → x2 → x4)

To move the enlarged photo image, press the ENTERE button, then press the ▲/▼/◄/► buttons. Note that when the 
enlarged picture is smaller than the original screen size, the location change function doesn’t work.
The enlarged file is not saved.

Background Music
You can select background music when watching a Slide Show.

To use this feature, there must be music and photo files stored on the USB device.
Loading music files is needed to change BGM mode. Play music files in music category to load.

Background Music → Off / On 
Off: Background music is not played.
On: When the background music is available, if you select On, the music is played back. 

BGM Mode → Mood / Selected File / Shuffle
You can select a mode to use for the background music.

BGM Mood → Energetic / Rhythmical / Sad / Exciting / Calm / Unclassified
Music with the mood you selected is set as the background music.

If you set BGM Mode to Mood, you can select a mood.

Select Music File (0 File(s) Selected)
Only the selected music file is set as the background music.

If you set BGM Mode to Selected File, you can select a music file.

Picture Setting / Sound Setting
You can select the picture and sound settings.

Information
The photo file information is displayed.

Remove Safely
You can remove the device safely from the TV.

¦

❑

❑

N
N

❑



N

❑

N
N
N

❑

N

N

❑

N
N



●
●





N



N

❑

❑

❑

Stop Slide Show
Slide Show Speed	 :	 Normal
Slide Show Effect	 :	 Fade1
Rotate
Zoom
Background Music
Picture Setting
Sound Setting
Information

▼
U Move     E Enter     e Exit

Tools

[650_Aus]BN68-02089A_02Eng.indb   36 2009-08-21   ¿ÀÈÄ 1:42:38



English - 37

Sorting the Music List
You can sort music files in the Music List by a particular standard.
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Music, then press the ENTERE button.
3.	 Press the ▲ button to move to the Sort key Section. 
4.	 Press the ◄ or ► button to select a sorting standard. (Basic View, Title, Artist, 

Mood, Genre, Folder, Preference)
The Music files are sorted according to the newly selected sorting standard.

5.	 Press the ▼ button to move to the File List Section. Press the ENTERE button to 
start playing music in the order selected by the user.

To move to the previous/next group, press the π (REW) or μ (FF) button.
Music information is automatically set. The mood information extracted from 
a music file may differ from the expectations of the user. You can change the 
mood and preference.
If there is no title information for a music file, the filename is displayed.
If no information is available for the Artist, Album, Year, or Genre the corresponding item is displayed as blank.

Basic View
Shows the folders of the USB memory device. If you select a folder and press the ENTERE button, only the music files 
contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Title
Sorts the music titles in symbol/number/alphabet/special order, and shows the music file.

Artist
Sorts the music file by artist in symbol/number/alphabet/special order.

Mood → Energetic / Rhythmical / Sad / Exciting / Calm / Unclassified 
Sorts music files by the mood. You can change the music mood information.

Genre
Sorts music files by the genre.

Folder
It sorts music files by the folder. If there are many folders in USB, the files are shown in order in each folder. The music file in the 
Root folder is shown first and the others are shown in alphabetical order by name.

Preference → FFF / FFF / FFF / FFF
Sorts music files by preference (Favourites). You can change the music files preferences.

Changing the Favourites Setting
Select the desired music file in the Music list, then press the Green button repeatedly until the desired setting appears. 
Up to 3 stars can be selected.
The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.

Music List Option Menu
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Music, then press the ENTERE button. 
3.	 Press the ◄ or ► button to select the desired Music file. 

Selecting Multiple Music Files
Press the ◄ or ► button to select the desired music file. Then press the 
Yellow button.
Repeat the above operation to select multiple music files.
The mark c appears to the selected music file.

4. 	 Press the TOOLS button.
The option menu changes according to the current status.
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Play Current Group
Using this menu, you can only play music files in the currently selected sorting group.

Copy / Copy Current Group / Copy the selected file (When multiple files are selected)
Select the music to copy. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Copy 
(or Copy Current Group / Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 
When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)
Select the file to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Delete 
(or Delete All / Delete Selected File). The files are deleted.

You can only delete the files saved in the TV memory.
You cannot recover a deleted file. 

Change Group (When the Sort key is Mood)
You can change the mood information of music files.
The group information of the current file is updated and the file is moved to the new group.

To change the information of multiple files, select files by pressing the yellow button.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The music file information including the name, the size, the date modified and the path is displayed.

You can view the music file information during Play Current Group using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.

Playing Music

Playing a music file

1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select a music file to be played.
3.	 Press the ∂ (Play)/ENTERE button.

This menu only shows files with the MP3 file extension. Files with other 
file extensions are not displayed, even if they are saved on the same USB 
device.
The selected file is displayed at the top with its playing time.
To adjust the music volume, press the volume button on the remote control. 
To mute the sound, press the MUTE button on the remote control.
If the sound is odd when playing MP3 files, adjust the Equalizer and SRS 
TruSurround HD in the Sound menu. (An over-modulated MP3 file may cause a sound problem.)
The playing duration of a music file may be displayed as ‘00:00:00’ if its playing time information is not found at the start of 
the file.
π (REW) or μ (FF) buttons do not function during play.

Music Play Control Buttons
Button Operations

ENTERE Play/Pause the music file.
∂ Play the music file
∑ Pause the music file
∫ Exit play mode and return to the music list.

TOOLS Run various functions from the Music menus.
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Music function information icon

p When all music files in the folder (or the selected file) are repeated. Repeat Mode is On.

q When all music files in the folder (or the selected file) are played once. Repeat Mode is Off.

Playing the music group

1.	 Press the ▲ button to move to the Sort key Section.
2.	 Press the ◄ or ► button to select a sorting standard.
3.	 Press the ▼ or ENTERE button to move to the Group List Section.
4.	 Press the ∂ (Play) button. The files of the selected group will start playing.

Alternatively 
1.	 Select a sort key and then in the File List Section, select the files contained in the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) button.
2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The music files in the sorting group including the selected file are played.

Playing the selected music files

1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select the desired music file.
3.	 Press the Yellow button.
4.	 Repeat the above operation to select multiple music files.

The c appears to the left of the selected music file.
To deselect all selected files, press the TOOLS button and select Deselect All.

5.	 Press the ∂ (Play)/ENTERE button.
The selected files will be played.

Music Play option Menu

Music Play Option Menu

Repeat Mode → On / Off
You can play music files repeatedly.

Picture Setting / Sound Setting
You can configure the picture and sound settings.

Information
The music file information is displayed.

Remove Safely
You can remove the device safely from the TV.

Sorting the Movie List
You can sort movies in the Movie List by a particular standard.
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Movie, then press the ENTERE button.
3.	 Press the ▲ button to move to the Sort key Section.
4.	 Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 

Title, Folder, Preference)
The movie files are sorted according to the newly selected sorting standard.

5.	 Press the ∂ (Play)/ENTERE button to play the movie in the order selected by 
the user.

Movie information is automatically set. You can change the preference.

N
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Basic View
Shows the folders of the USB memory device. If you select a folder and press the ENTERE button, only the movie files 
contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Timeline
Sorts movies by date. It sorts by year and month from the earliest movie.

Title
Sorts and displays the movie titles in symbol/number/alphabet/special order.

Folder
If there are many folders in USB, the movies files are shown in order in each folder. The movie file in the Root folder is shown first 
and the others are shown in alphabetical order by name.

Preference → FFF / FFF / FFF / FFF
Sorts movies by preference. (Favourites) You can change the movie preferences.

Changing the Favourites Setting
Select the desired movie file in the movie list, then press the Green button repeatedly until the desired setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.

Movie List Option Menu
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Movie, then press the ENTERE button. 
3.	 Press the ◄ or ► button to select the desired Movie file. 

Selecting Multiple Movie Files
Press the ◄ or ► button to select the desired movie file. Then press the 
yellow button.
Repeat the above operation to select multiple movie files.
The mark c appears to the selected movie file.

4. 	 Press the TOOLS button.
The option menu changes according to the current status.

Play Current Group
Using this menu, you can only play movie files in the currently selected sorting group.

Copy / Copy Current Group / Copy the selected file (When multiple files are selected)
Select the movie to copy. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 
Copy (or Copy Current Group / Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 
When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)
Select the file to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Delete 
(or Delete All / Delete Selected File). The files are deleted.

You can only delete the files saved in the TV memory.
You cannot recover a deleted file. 

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The movie file information including the name, the size, the date modified and the path is displayed.

Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Playing a Movie File

Playing a movie file

1.	 Press the ▼ button to select the File List Section. 
2.	 Pressing the ◄ or ► button to select a movie file to be played.
3.	 Press the ∂ (Play)/ENTERE button.

The selected file is played.
The selected file is displayed at the top with its playing time.
The playing duration of a movie file may be displayed as ‘00:00:00’ if its 
playing time information is not found at the start of the file.
You can watch exciting gaming multimedia files, but the gaming function is not 
supported.

Supported Subtitle Formats
Name File extension Format

MPEG-4 time-based text .ttxt XML
SAMI .smi HTML

SubRip .srt string-based
SubViewer .sub string-based
Micro DVD .sub or .txt string-based

Supported Movie Formats

File extension Container Video Decoder Audio codec Resolution

*.avi AVI

Divx 3.11 / 4.x / 5.1 / 6.0

MP3
AC3

LPCM
ADPCM

720x576

XviD 1920x1080

H.264 BP / MP / HP 1920x1080

MPEG4 SP / ASP 1920x1080

Motion JPEG 800x600

*.mkv MKV

Divx 3.11 / 4.x / 5.1 / 6.0

MP3
AC3

LPCM
ADPCM

720x576

XviD 1920x1080

H.264 BP / MP / HP 1920x1080

MPEG4 SP / ASP 1920x1080

Motion JPEG 800x600

*.asf ASF

Divx 3.11 / 4.x / 5.1 / 6.0
MP3
AC3

LPCM
ADPCM

WMA

720x576

XviD 1920x1080

H.264 BP / MP / HP 1920x1080

MPEG4 SP / ASP 1920x1080

Motion JPEG 800x600

*.wmv ASF VC1 WMA 1920x1080

*.mp4 MP4
(SMP4)

H.264 BP / MP / HP
MP3

ADPCM
AAC

1920x1080

MPEG4 SP / ASP 1920x1080

XVID 1920x1080

*.3gp 3GPP
H.264 BP / MP / HP ADPCM

AAC
1920x1080

MPEG4 SP / ASP 1920x1080

*.vro VRO
VOB

MPEG2 AC3
MPEG
LPCM

1920x1080

MPEG1 1920x1080

*.mpg
*.mpeg PS

MPEG1 AC3
MPEG
PCM

1920x1080

MPEG2 1920x1080

*.ts
*.tp
*.trp

TS

MPEG2
AAC
MP3

1920x1080

H.264 1920x1080

VC1 1920x1080

¦

N
N
N

N

N

N
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Video Play Control Buttons
Button Operations

ENTERE Play/Pause the movie file
∂ Play the movie file
∑ Pause the movie file

TOOLS Run various functions from the Movie menus.
∫ Exit play mode and return to the movie list.

◄ / ► Skip forwards or backwards through the movie file. 
▲ / ▼ Move to the first/last of the file.
μ Play the file at double speed. This function may not be supported depending on the codec.

Playing the movie group

1.	 Press the ▲ button to move to the Sort key Section.
2.	 Press the ◄ or ► button to select a sorting standard. 
3.	 Press the ▼ or ENTERE button to move to the Group List Section.
4.	 Press the ∂ (Play) button. Only the files of the selected group will start playing.

Alternatively 
1.	 Select a Sort key and then in the File List Section, select the files contained in the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) button.
2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The movie files in the sorting group including the selected file are played.

Playing the selected movie files

1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select the desired movie file.
3.	 Press the Yellow button. 

The c mark appears to the left of the selected movie file.
To deselect all selected files, press the TOOLS button and select Deselect All.

4.	 Repeat the above operation to select multiple movie files.
5.	 Press the ∂ (Play)/ENTERE button.

Only the selected file is played.

Playing movie continuously (Resume Play)
If you exit playing movie function, the movie can be played later from the point where it was stopped.
1.	 Select the movie file you want to play continuously by pressing ◄ or ► button to select it from the File List Section.
2.	 Press the ∂ (Play)/ENTERE button.
3.	 Select Play Continuously (Resume Play) by pressing the Blue button.

The Movie will begin to play from where it was stopped .
If Cont. movie play help function was set On in the Setup menu, a pop-up message will appear when you resume play 
a movie file.

Movie Play Option Menu

Movie Play Option Menu

Picture Setting / Sound Setting
You can configure the picture and sound settings.

Picture Size

Fit
Play video at the TV screen size.

Original
Play video at the original size.

N
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Caption Setting
You can set the captions for the movie.

Caption → On / Off
You can turn the captions for the movie on or off.

Caption Size → Small / Standard / Large
You can change the font size of the captions.

Caption Sync.
You can adjust the caption sync.

Caption Sync Reset
You can reset the adjusted caption sync.

Information
The movie file information is displayed.

Remove Safely
You can remove the device safely from the TV.

Using the Setup Menu
Setup displays the user settings of the Media Play menu.
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Setup, then press the ENTERE button.
3.	 Press the ▲ or ▼ button to select the desired option.
4.	 Press the ◄ or ► button to select the desired option.

To exit Media Play mode, press the MEDIA.P button on the remote control.

Use Colour View → On / Off
You can select sorting photos by colour. If this option is set to On, the loading time may 
be increased to collect colour information from the photos.

Music Repeat Mode → On / Off
Select to repeatedly play music files.

Cont. movie play help → On / Off
Select to display the help pop-up message for continuous movie playback.

Get the DivX® VOD registration code
Shows the registration code authorized for the TV. If you connect to the DivX web site and register the registration code with a 
personal account, you can download VOD registration file.
If you play the VOD registration using Media Play, the registration is completed.

For more information on DivX® VOD, visit www.DivX.com.

Get the DivX® VOD deactivation code
When DivX(R) VOD is not registered, the registration deactivation code is displayed.
If you execute this function when DivX® VOD is registered, the current DivX® VOD registration is deactivated.

Screen Saver Run Time → 2 hours / 4 hours / 8 hours
Select to set the waiting time before the screen saver appears.

Information
Select to viewing the information of the connected device.

Remove Safely
You can remove the device safely from the TV.
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Media Play-DLNA

Setting the DLNA Network
DLNA allows you to watch pictures, musics and videos saved on your PC on your TV through a network connection in Media Play 
mode. This removes the need to copy them to a USB storage device and then connect the device to your TV. To use DLNA, the TV 
must be connected to the network and the DLNA application must be installed on your PC.

Network Connection Diagram-Cable

Network Connection Diagram-Wireless

1.	 For more information on how to configure your network, refer to pages 23~28.
You are recommended to locate both TV and PC in same subnet. The first 3 parts of the subnet address of the TV and 
the PC IP addresses should be the same and only the last part (the host address) should be changed. (e.g. IP Address: 
123.456.789.**)

2.	 Connect the PC to which the Samsung PC Share Manager programme will be installed and the external modem using a LAN 
cable.

You can connect the TV to the PC directly without connecting it through a Sharer (Router).

Installing the DLNA Application
To play content on the PC on the TV, you have to first install the application. To use the DLNA function smoothly, use the 
programme in the CD-ROM supplied with the TV or use the Samsung PC Share Manager programme corresponding to the TV 
model that can be downloaded from the Samsung web site.

System Requirements

1.	 Insert the Programme CD supplied with this TV into your PC.
2.	 30MB of free hard disk space is needed for the programme installation.

If you share files, up to 30MB of hard disk drive space is required for each 100 files.
If you cancel file sharing, the hard disk drive space used for the thumbnail information is also freed.

¦

N

N

¦

N
N

LAN

External Modem  
(ADSL/VDSL/Cable TV)

TV
PC

LAN

LAN Cable
Wireless IP sharer

TV
PC

TV Side Panel
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Samsung Wireless 
LAN Adapter
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Supported Formats
Image: JPEG/ Audio: MP3/ Video: AVI, MKV, ASF, MP4, 3GPP, PS, TS container. For detailed supported video formats, refer 
to page 41.

Install the application

 



1.	 Run the Setup.exe file on the 
Programme CD supplied with the 
product.

Alternatively, you can download 
the file from www.samsung.com.

2.	 Install the SAMSUNG PC Share 
Manager as shown in the figures 
below.

3.	 When the installation is complete, the 
PC Share Manager icon appears on 
your Desktop.

Double-click the icon to run the 
programme.

N

N

Using the DLNA Application

The Programme Screen Layout

1

3 4 5
6 7

2

1.	 Menus: The following application menus are provided : File, Share, Server, and Help.
2.	 Click to share the selected PC server folder.
3.	 Click to cancel sharing.
4.	 Click to refresh the PC folder and files.
5.	 Click to synchronize the share status.
6.	 The folders and files of the PC to be shared are listed.
7.	 Folders shared by the user are listed.

●

¦
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File

Property
Shows information on the selected file or folder.

Method 1: Select a file or folder and select the File menu and then select the Property sub-menu.
Method 2: Select a file or folder, right-click over the selected file or folder and then select Property from the pop-up menu.

<Method 1> <Method 2>
 

Exit
Exits the DLNA application.
If you select Exit without applying the changes after changing the shared status, a message will appear asking if you want to apply 
the changed settings to the PC. Select Yes to apply the changes and exit the application.

Share

Sharing a Folder
You can share a folder from your PC to the TV. The maximum number of folders that can be shared is 32.

Your PC will operate as a server to the TV.
Method 1: Select a folder in My Computer, select the Share menu and then select the Share Folder sub-menu.
Method 2: Select a folder in My Computer, right-click over the selected folder and then select Share Folder from the popup 
menu.
Method 3: Locate the mouse pointer over a folder in the My Computer folder list in the left pane and drag&drop the folder into 
the Shared Folders pane. If a message appears asking you to confirm the shared folder, select Yes.

<Method 1> <Method 2> <Method 3>

Cancelling a Shared Folder
You can cancel a shared folder on your PC. Select a folder from the Shared Folder pane and select Unshare Folder.

Method 1: Select a folder from the Shared Folder pane, select the Share menu and then select Unshare Folder.
Method 2: Select a folder from the Shared Folder pane, right-click over the selected folder and then select Unshare Folder 
from the pop-up menu.
Method 3: Locate the mouse pointer over a folder in the Shared Folder pane and drag&drop the folder into the My Computer 
pane. If a message appears asking you to confirm the cancelation, select Yes.

❑



●
●



❑



N
●
●

●



●
●

●
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<Method 1> <Method 2> <Method 3>

Applying the Current Settings
Perform this when synchronization is necessary due to a new shared folder or cancelling a shared folder. The Set Changed State 
menu applies changes to shared folders to the data saved with the PC share programme.
Since applying changes to the internal data is a time-consuming process, this function enables users to apply changes to the data 
only when required.
Until the Set Changed State menu is selected, the changed state of the shared folder is not applied to the server.
Changes to the shared folders are not applied to your PC until you select the Set Changed State menu.

Method 1: Select the Share menu and select the Refresh DB sub-menu.
Method 2: Click the Set Changed State icon.

<Method 1> <Method 2>
 

Setting the Access Permission
To enable the TV to find your PC, the TV must be set to Set Device Policy in the Access Permission Settings window. In addition, 
the PC server and the TV must be on the same subnet.

Method: Select the Share menu and select Set Device Policy. Rejected items are represented in gray. You can change the 
access permissions by using the Allow Accept / Deny button. To delete an item, select the item and select Delete Item.

Server

Server
You can run or stop using your PC as a server.

Run DLNA Digital Media Server when Windows Starts
You can determine whether to start the PC server automatically when Windows starts.

Change server name
You can rename the PC server. Enter a new name and click OK. The new name will appear at the top right of the window and will 
appear on the TV.

Help

Version
The programme version information message box appears.



●
●



●

❑







❑


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Using the DLNA Function

Using the DLNA Menu
DLNA (Digital Living Network Alliance) enables content saved on a DLNA server (usually your PC) connected to your TV or over 
a network to be played. Media Play enables playing content saved on a USB memory device connected to the TV, while DLNA 
enables playing content saved on a DLNA server (your PC) connected to your TV or over the network. The procedures to use the 
content are the same as those for Media Play (USB & DLNA).

If you install the PC share manager programme supplied with the TV onto a PC, you can have the PC perform the role of a 
DLNA server over the network.
For detailed procedures on using the DLNA menu, refer to pages 45~47.

1.	 Press the MEDIA.P button on the remote control to display the DLNA menu.
2.	 Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then press the ENTERE button.

To exit DLNA mode, press the MEDIA.P button on the remote control.
DLNA does not support the following functions. 

The Background Music and Background Music Setting functions.
Sorting files by preference in the Photo, Music, and Movie folders.
The Change Group Info function.
The Copy / Delete function.
The Remove Safely function.
The REW/FF (π/µ) key functions while a movie is playing.
Playing Movie Continuously (Resume Play) function.

The Skip function may not work with some container such as asf and mkv.
The Divx DRM, Multi-audio, embedded caption does not supported.
Samsung PC Share manager should be permitted by the firewall programme on your PC.
The Skip (◄/► keys) or Pause function may not work while a movie is playing for the DLNA of other manufacturers, 
depending on the corresponding content information.
The playing time may not be displayed while a movie is playing.
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ANYNET+

Connecting Anynet+ Devices

What is Anynet+?
Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s 
remote. The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung 
device has this feature, check if there is an Anynet+ logo on it.

To connect to a TV

1.	 Connect the HDMI IN (1, 2, 3(DVI) or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

To connect to Home Theatre

1.	 Connect the HDMI IN (1, 2, 3(DVI) or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

2.	 Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.

Connect the Optical cable between the DIGITAL AUDIO OUT (OPTICAL) jack on your TV and the Digital Audio Input on 
the Home Theatre.
When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the 
Home Theatre’s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the 
DIGITAL AUDIO OUT (OPTICAL) jack on the DVD / Satellite Box (ie Anynet Device 1 or 2) directly to the Amplifier or 
Home Theatre, not the TV.
Connect only one Home Theatre.
You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.
Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.
Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.

¦

N

N

N
N
N
N

TV

HDMI 1.3 
Cable

Anynet+ 
Device 2

Anynet+ 
Device 3

HDMI 1.3 
Cable HDMI 1.3 

Cable

Anynet+ 
Device 1

Anynet+ 
Device 4

HDMI 1.3 
Cable

TV

HDMI 1.3 Cable

Anynet+ 
Device 1

Anynet+ 
Device 2

Anynet+ 
Device 3

HDMI 1.3 Cable HDMI 1.3 Cable
Anynet+ 
Device 4Home Theatre

Optical Cable

HDMI 1.3 Cable
HDMI 1.3 Cable

[650_Aus]BN68-02089A_02Eng.indb   49 2009-08-21   ¿ÀÈÄ 1:42:46



English - 50

Setting Up Anynet+
Press the TOOLS button to display the Tools menu. You can also display Anynet+ menu by 
selecting Tools → Anynet+ (HDMI-CEC).

Setup

Anynet+ (HDMI-CEC) → Off / On
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must be set to On.

When the Anynet+ (HDMI-CEC) function is disabled, all the Anynet+ related operations are 
deactivated.

Auto Turn Off → No / Yes
Setting an Anynet+ Device to turn Off automatically when the TV is Turned Off and setting a TV 
to turn off automatically when a HDMI-CEC device requestes tv to turn off.

The active source on the TV remote must be set to TV to use the Anynet+ function.
If you set Auto Turn Off to Yes, connected external devices are also turned off when the 
TV is turned off. If an external device is still recording, it may or may not turn off.

Switching between Anynet+ Devices
1.	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.	 Press the ▲ or ▼ button to select Device List, then press the ENTERE button.

Anynet+ devices connected to the TV are listed.
If you cannot find a device you want, press the red button to scan for devices. 

3.	 Press the ▲ or ▼ button to select a particular device and press the ENTERE button. It 
is switched to the selected device.

Only when you set Anynet+ (HDMI-CEC) to On in the Application menu, the Device 
List menu appears.

Switching to the selected devices may take up to 2 minutes. You cannot cancel the 
operation during the switching operation.
The time required to scan for devices is determined by the number of connected devices.
When the device scan is complete, the number of devices found are not displayed.
Although the TV automatically searches the device list when the TV is turned on via the power button, devices connected to 
the TV may not always be automatically displayed in the device list. Press the red button to search for the connected device.
If you have selected external input mode by pressing the SOURCE button, you cannot use the Anynet+ function. Make sure to 
switch to an Anynet+ device by using the Device List.

Anynet+ Menu
The Anynet+ menu changes depending on the type and status of the Anynet+ devices connected to the TV.

Anynet+ Menu Description
View TV Anynet+ mode changes to TV broadcast mode.
Device List Shows the Anynet+ device list.

(device_name) MENU Shows the connected device menus. E.g. If a DVD recorder is connected, the disc 
menu of the DVD recorder will appear.

(device_name) INFO Shows the play menu of the connected device. E.g. If a DVD recorder is connected, 
the play menu of the DVD recorder will appear.

Recording: (*recorder) Starts recording immediately using the recorder. (This is only available for devices that 
support the recording function.)

Stop Recording: (*recorder) Stops recording.
Receiver Sound is played through the receiver.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 
connected, it will be represented as (*device_name).
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TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, when the 
menu of the corresponding device is 
displayed on the screen.

Numeric buttons
▲/▼/◄/►/ ENTERE buttons
Colour buttons / EXIT button

After switching to the device, while playing 
a file

π(Backward search) / μ(Forward search) / 
∫(Stop) / ∂(Play) / ∑(Pause)

Device with built-in 
Tuner

After switching to the device, when you 
are watching a TV programme P > / P < button

Audio Device When Receiver is activated Volume / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set to TV.
The ∏ button works only while in the recordable state.
You cannot control Anynet+ devices using the buttons on the TV. You can control Anynet+ devices only using the TV remote 
control.
The TV remote control may not work under certain conditions. If this occurs, reselect the Anynet+ device.
The Anynet+ functions do not operate with other manufacturers’ products.
The π, μ operations may differ depending on the device.

Recording
You can make a recording of a TV programme using a Samsung recorder.
1.	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.	 Press the ▲ or ▼ button to select Recording Immediately and press the ENTERE 

button. Recording begins.
When there is more than one recording device
When multiple recording devices are connected, the recording devices are listed. 
Press the ▲ or ▼ button to select a recording device and press the ENTERE 
button. Recording begins.
When the recording device is not displayed select Device List and press the red 
button to search devices

3.	 Press the EXIT button to exit.
You can record the source streams by selecting Recording: (device_name).
Pressing the ∏ button will record whatever you are currently watching. If you are watching video from another device, the 
video from the device is recorded.
Before recording, check whether the antenna jack is properly connected to the recording device. To properly connect an 
antenna to a recording device, refer to the recording device’s users manual.

Listening through a Receiver (Home theatre)
You can listen to sound through a receiver instead of the TV speaker.
1.	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.	 Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select On or Off.
3.	 Press the EXIT button to exit.

If your receiver supports audio only, it may not appear in the device list.
The receiver will work when you have properly connected the optical in jack of the 
receiver to the DIGITAL AUDIO OUT (OPTICAL) jack of the TV.
When the receiver (home theatre) is set to On, you can hear sound output from 
the TV’s Optical jack. When the TV is displaying a DTV(air) signal, the TV will send 
out 5.1 channel sound to the Home theatre receiver. When the source is a digital 
component such as a DVD and is connected to the TV via HDMI, only 2 channel sound will be heard from the Home 
Theatre receiver.
If there is a power interruption to the TV when the Receiver is set to On (by disconnecting the power cord or a power 
failure), the Speaker Select may be set to External Speaker when you turn the TV on again.
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Troubleshooting for Anynet+

Problem Possible Solution
Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ 

devices only.
Connect only one receiver (home theatre).
Check if the Anynet+ device power cord is properly connected.
Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Check whether the TV remote control is in TV mode.
Check whether it is Anynet+ exclusive remote control.
Anynet+ doesn’t work in certain situations. (Searching channels, Operating Media Play, 
Plug & Play, etc.)
When connecting or removing the HDMI 1.3 cable, please make sure to search devices 
again or turn your TV off and on again.
Check if the Anynet+ Function of Anynet+ device is set on.

●

●
●
●
●
●
●
●

●

●
I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ 

(HDMI-CEC) is set to On in the Anynet+ Setup menu.
Press the TV button on the TV remote control to switch to TV. Then press the TOOLS 
button to show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.
Press the SOURCE button on the TV remote control and select a device other than 
Anynet+ devices.
Press P >/<, CH LIST, PRE-CH, and FAV.CH to change the TV mode. (Note that 
the channel button operates only when a tuner-embedded Anynet+ device is not 
connected.)

●
●

●

The message 
‘Connecting to Anynet+ 
device...’ appears on the 
screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a 
view mode.
Use the remote control when the Anynet+ setting or switching to view mode is 
complete.

●

●

The Anynet+ device does 
not play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is 
not displayed.

Check whether or not the device supports Anynet+ functions.
Check whether or not the HDMI 1.3 cable is properly connected.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Search Anynet+ devices again.
You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables 
may not support Anynet+ functions.
If it is terminated by an abnormal situation such as disconnecting the HDMI cable or 
power cord or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV programme 
cannot be recorded.

Check whether the antenna jack on the recording device is properly connected.●

The TV sound is not 
output through the 
receiver.

Connect the optical cable between TV and the receiver.●

¦
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CONTENT LIBRARY

Using the Content Library
The Content Library allows you to enjoy various content on your TV. You can use the default 
content stored in the TV memory or you can enjoy new content using a USB device.

Using the Content Library Menu

�. Press the MENU button. Press the ▲ or ▼ button to select Application, then press the 
ENTERE button.

�. Press the ▲ or ▼ button to select Content Library, then press the ENTERE button.
The Content Library main menu is displayed.

�. Press the ◄ or ► button to select an icon (Gallery, Cooking, Game, Children, Wellness, Others, Content Management), 
then press the ENTERE button.

Using the Remote Control Button in Content Library Menu

Button Operations
▲/▼/◄/► Move the cursor and select an item.
ENTERE Select the currently selected item.
RETURN Return to the previous menu.

EXIT Stop the current function and return to the Content Library main menu.
< P > Stop Content Library mode and Returns to TV mode.

Colour button Keys that provide functions are described on the corresponding page.
Y / MUTE You can control the volume of the played content.

CONTENT LIBRARY CONTAINS TEXT, GRAPHICS, IMAGES, MULTIMEDIA, AND OTHER MATERIALS FOR 
INFORMATIONAL AND PROMOTIONAL PURPOSES ONLY. MATERIALS IN CONTENT LIBRARY HAS BEEN MODIFIED AND 
KEEPS BEING REVISED AND UPDATED. THE MATERIALS IN THE CONTENT LIBRARY MAY NOT BE SUITABLE FOR ALL 
AUDIENCES.
INFORMATION IN THE CONTENT LIBRARY IS PROVIDED ‘AS IS.’ ALTHOUGH THE INFORMATION PROVIDED TO YOU 
IN THE CONTENT LIBRARY IS OBTAINED OR COMPLIED FROM SOURCES WE BELIEVE TO BE RELIABLE, SAMSUNG 
CANNOT AND DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS OR COMPLETENESS
OF ANY INFORMATION OR DATA MADE AVAILABLE TO YOU FOR ANY PARTICULAR PURPOSE. UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE HELD LIABLE, WHETHER IN CONTRACT OR TORT, 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY FEES, EXPENSES, 
OR ANY OTHER DAMAGES WHATSOEVER ARISING OUT OF, OR IN CONNECTION WITH, ANY INFORMATION 
CONTAINED IN, OR THE USE OF, THE CONTENT LIBRARY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Using the TV Memory Contents
You can use enjoy content stored in the TV memory. You can add/delete content to/from the TV memory. To add/delete content, 
select Content Management.

To return to Content Library main menu, press the EXIT button.
The volume display does not appear but You can control the volume.

Gallery
This function plays a SlideShow with high resolution images and background music and 
produces various atmospheres. Using the Gallery function of the TV, you can change your 
home atmosphere.

The copyrights of the Gallery contents and all issues related to them are reserved by 
TimeSpace, Inc. 
Press the ENTERE button to pause the SlideShow, and also press the ENTERE button 
to resume the SlideShow.
Press the INFO button to display information on the selected photo. (This is not displayed if 
the photo has no information.)
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Cooking
You can view various recipes and then easily follow them step by step. Enjoy these contents which will give you great ideas for 
meals.

The recipes introduced in the Cooking contents on the Samsung TV are based on recipes published by Anness Publishing.
The copyrights of the Cooking contents and all issues related to them are reserved by Practical Pictures.

Game
This category provides entertainment games for the whole family.

For the buttons used in the games, refer to the directions on the screen.
Colour Buttons for Games

Button Operations
Red Press to move to the game home screen

Green Press to pause the game
Yellow Option Key
Blue Press to exit the game

Children
This is educational and interactive content that children can watch repeatedly. 

The copyrights of the Children contents and issues related to them reserved by UpToTen.

Wellness
This is benefi cial health management content that can be enjoyed by the whole family. 

Others 
The default content is not saved in the TV memory.

You can copy new content to the TV memory using the Content Management screen.

Using the Content Management

Content Management
You can add or delete contents using the Content Management.

You can select multiple content items by selecting content items repeatedly and pressing 
the Yellow button.

My Contents
You can check the content saved in the TV memory for each subitem of the Content Library.

Select a content item and press the ENTERE button. You can play or delete the selected 
content item.

USB
You can check the content saved on the USB device for each subitem of the Content Library.
Select a content item and press the ENTERE button. You can play the selected content item 
or copy it to the TV memory.

Content Library only supports USB Mass Storage Class devices (MSC). MSC is a Mass 
Storage Class Bulk-Only Transport device. Examples of MSC are Thumb drives and Flash Card Readers.
Playing a game using an external USB memory device will allow you to save your game (depending on the game). Take care 
as removing the USB memory device while saving data to the USB memory device may cause the data to be lost.
Downloading New Contents
New content other than the built-in content will be provided via the Samsung.com website free of charge. When you download 
the paid contents, you need UDN number to download contents. Check the UDN number before downloading a new content 
item.
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Downloading Content
1.	 Visit the www.samsung.com website and open the Content Library page.
2.	 Select a content item in the Contents Download page.
3.	 Download the contents onto the USB memory device.
4.	 Go to Content Library main menu by pressing CONTENT button or choosing Content Library (Menu → 

Application → Content Library).
5.	 Plug the USB memory into USB port on the side of the TV.
6.	 You can see the content sub item which you downloaded.
7.	 Select a content item and press the ENTERE button.
8.	 You can play the selected content item.

Setup
Screen Saver Run Time: Select to set the waiting time before the screen saver appears.
Save UDN: Saves the UDN number to a USB device.
An NTFS format USB storage device does not support to save UDN. Recommended to use FAT format USB storage device.

●



●
●
N

Internet@TV
This function may not be supported depending on your country.
If you have some problems while using a widget service, please contact to service provider.
 In the widget, press the green button and get contact information or refer to help website for service provider information.
English may be only supported in widget service depending on region.

Getting Started with Internet@TV
Internet@TV provides SAMSUNG’s widget services through a network connection. Internet@TV contents can be changed 
depending on contents provider. You can access various information such as YouTube, through the Internet@TV service. 

The configuration of Widgets and their provided services may differ according to the selected country. After changing country, 
turn off and on the TV. Then you can use widget service supported changed country. If Country is set to Others, TV can’t 
recognize your country. In this case, please select directly from the service country list.
If a certain content’s font provided by contents provider is not supported on TV, It may not be viewed normally.
For more information on how how to configure your country, refer to page 8. 
You may experience slow operation or hesitation when using this function due to network conditions.
Before using Internet@TV, set up the network first. For more information on how to configure your network, refer to pages 26~28.

When running Internet@TV for the first time, the basic settings proceed automatically. It may take few minutes to update.
1.	 Press the MENU button. Press the ▲ or ▼ button to select Application, then press the ENTERE button.
2.	 Press the ▲ or ▼ button to select Internet@TV, then press the ENTERE button.

Press the Internet@ button on the remote control to display the Internet@TV menu.
3.	 The ‘User Agreement’ is displayed. Select Agree to accept the agreement.
4.	 The ‘Statistics & Analysis’ is displayed. Select Agree to accept the agreement.

Setting up Internet@TV
You can check and use the menus regarding Single Sign On (SSO), system management and properties. Press the ▲ or ▼ 
button to select Setup, then press the ENTERE button.

Single Sign On
You can use this menu when creating, deleting the account.
Using the Single Sign On, you can control your account including contents site’s account information.
You don’t need additional log in.

Account is only for internet@TV.

Create Account
You can create account and be linked with desired service site.

Account will be made less than 10.
Character of Account should be limited to 10.
If there is no service that needs log in, you can not create account.
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Account Management
Service Site: You can register log in information of service site (such as YouTube).
Change Password: Change the password of your account.
Delete: Delete the account.
If you forget the password of account, press the remote control buttons in the following sequence, which resets the Internet@
TV: POWER (Off) → MUTE → 9 → 4 → 8 → POWER (On) . 
If you use this function, all accounts will be deleted.

System Setup
Ticker Autorun, Ticker Duration may not be supported depending on country.

Change the Service Lock password
The default password number of a new TV set is 0-0-0-0.
If you forget the password, press the remote control buttons in the following sequence, which resets the password to 0-0-0-0: 
POWER (Off) → MUTE → 8 → 2 → 4 → POWER (On).

Service Duration
Select to set the service duration time before the screen saver appears.

Ticker Autorun → Off / On
Select to set ticker to run automatically or not when turning on the TV.

Ticker Duration
Select to set the service duration time before the screen saver appears.

Properties
Display information of Internet@TV.
You can measure the speed of your Internet TV service using Measuring the speed of the Internet TV service.

Using the Internet@TV service
In a widget that provides multiple category menus, you can view the contents of the category menus using the ◄ and ► buttons.

Account Login
1.	 Press the Red button.
2.	 Select desired User account, then press the ENTERE button.
3.	 Input the password.

When login succeeds, User account will be displayed on the screen.
Before login, at least one and more account should be registered. If you want to create account, refer to page 55.

Using the Widget Gallery
You can use Run Service, Lock, Install Service at the existing widget and you can see description of the widget service that isn’t 
installed.
On the Internet@TV, you can add and use various widgets provided by service provider. It may vary according to contents 
provider.

Run Service: Runs the widget service.
Lock: Set the service lock
Install Service (or Delete Service): Install or delete widget service.

Using the YouTube Widget
You can watch the movie provided by YouTube.
If you have the account in YouTube, Register account information using Account 
management. Then, you can use My Favourites category.

The menu can be changed by web service.
There may be inappropriate contents for child. In this case, use Lock function in 
Widget Gallery.
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Troubleshooting for internet@TV

Problem Possible Solution
Some widget services do not work. Check with that service provider.

In the widget, press the green button and get contact information or refer to help 
website for widget service provider information.
Refer to Help website page.

What is the advantage of single sign 
on?

If you create account and register your login information of desired service, you can 
access personalized content without additional login.

When a network error occurred, I can’t 
use other menus except setting menu.

If network connection doesn’t work, your service might be limited.
Because all of function except setting menu are needed to connect internet.

Is there any possibility to show adult 
movies on YouTube?

Basically, at the list on the menu it is filtered out. But by using search function, It can 
be shown. In this case, using the Widget Gallery lock the widget service.

Help Website

Country Website
UAE www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Australia www.samsung.com → Consumer → television → medi@2.0 → Internet@TV
China www.samsung.com → 个人消费产品 → 电视产品 → medi@2.0 → Internet@TV
India www.samsung.com → consumer products → television → medi@2.0 → Internet@TV

Indonesia www.samsung.com → Produk → television → medi@2.0 → Internet@TV

Japan www.samsung.com → 製品情報 → 液晶ディスプレイ → medi@2.0 → Internet@TV
Malaysia www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

New Zealand www.samsung.com → Consumer → television → medi@2.0 → Internet@TV
Philippines www.samsung.com → Consumer → television → medi@2.0 → Internet@TV
Singapore www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Taiwan www.samsung.com → 個人消費産品 → 電視 → medi@2.0 → Internet@TV

Thailand www.samsung.com → ผลิตภัณฑ์  → โทรทัศน์ → medi@2.0 → Internet@TV
Vietnam www.samsung.com → sản phẩm nghe nhìn → máy thu hình → medi@2.0 → Internet@TV

South Africa www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Approaching step may be changed later on.
It can be different links for special countries.
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Home Network Centre

Home Network Centre
About the Home Network Centre
The Home Network Centre connects the TV and mobile phones through a network. You can view call arrivals, text message 
contents, and schedules set on the mobile phone on the TV using the Home Network Centre. In addition, you can play the media 
contents saved on the mobile phones such as videos, photos and music by controlling them onto the TV via the network.

If the device supports DLNA DMC (Digital Media Controller) function, Home Network Centre function is available.
This function is for compatibility with Samsung mobile phone which will be released later on. For more information, visit www.
samsung.com or contact Samsung call centre. The mobile device may need additional software installation. For details, refer 
to each user’s guide.

Connecting to the Home Network Centre 
For more information about the network settings, refer to pages 23~28.

Connecting to a Wi-Fi Ad-hoc network
1.	 Connect the ‘Samsung Wireless LAN Adapter’ to the USB1(HDD) or USB2 port of the TV.

2.	 For more information on how to configure Ad-hoc network, refer to refer to page 28.
For information on configuring the mobile phone’s network settings, refer to the mobile phone manual.

3.	 Set up the IP address, SSID and password for the mobile phone in the Ad-hoc Settings of the mobile phone using the 
Network Name (SSID) and Security Key (password) displayed on the TV.
Connecting through a wire / wireless IP sharer 

1.	 Connect the LAN port of the TV and the Wire/Wireless IP sharer using the LAN cable or connect the USB1(HDD) or USB2 
port of the TV and the ‘Samsung Wireless LAN Adapter’.

For the procedures to set up the wire/wireless sharer and the mobile phone, refer to the manual of the corresponding 
device.

¦

N
N

●

N

●

N

Mobile phoneTV Side Panel
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TV Rear Panel
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Setting Up the Home Network Centre

Message 
Shows a list of mobile phones which have been set up with this TV to use the 
message function (the call arrivals, text message contents and schedules set on the 
mobile phone).

Allowed
Allows the mobile phone.

Denied
Blocks the mobile phone.

Delete
Deletes the mobile phone from the list.

This function just deletes the name from the list. If the deleted mobile device turns on or tries to connect to the TV, it may be 
shown on the list.

Media 
Shows a list of mobile phones which is available to control media contents (videos, 
photos, music) from the phone.

Besides mobile phone, other mobile devices that support DLNA DMC are available.

Allowed
Allows the mobile phone.

Denied
Blocks the mobile phone.

Delete
Deletes the mobile phone from the list.

This function just deletes the corresponding name on the list. If the deleted mobile device turns on or tries to connect to the 
TV, it may be shown on the list.

Setup

Message → On / Off
You can determine whether to use the message function (the call arrivals, text message 
contents, and schedules set on the mobile phone).

Media → On / Off
You can select whether to use the Media function that plays the contents (videos, 
photos, music) from the mobile phone.

TV name
You can set the TV name so as to find it easily on the mobile device.

If you selects User Input, you can type the TV name by OSK(On Screen 
Keyboard).

¦

❑







N

❑

N







N
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





N

Message	 : On

Media	 : On

TV name	 : TV

Home Network Centre 

Message

Media

Setup

 R Return     e Exit

111-1234-5671 	 : Allowed

111-1234-5672	 : Allowed

111-1234-5673 	 : Denied

111-1234-5674 	 : Denied

Home Network Centre 

Message

Media

Setup

 R Return     e Exit

111-1234-5671 	 : Allowed

111-1234-5672	 : Allowed

111-1234-5673 	 : Denied

111-1234-5674 	 : Denied

Home Network Centre 

Message

Media

Setup

 R Return     e Exit
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Using the Message Function
Using this function, you can view the call arrivals, text message contents and schedules 
set on the mobile phone through the alarm window while watching TV. 

To disable this Message alarm window, set Message to Off in Setup of the Home 
Network Centre.
The alarm window appears for 20 seconds. If no key is pressed or if Cancel is 
selected, it appears up to three times at 5 minute intervals.
If OK is selected, or if OK is not selected while the message is displayed three 
times, the message will be deleted. The message is not deleted from the mobile 
phone. 
The simple alarm window can be displayed, while using some applications such as 
Media Play, Content Library, etc. In this case, to view the contents of the message, 
switch to TV viewing mode.
When the message of an unknown mobile phone is displayed, select the mobile 
phone in the Message item of the Home Network Centre and select Denied to 
block the phone.

Message View
If a new text message (SMS) arrives while you are watching TV, the alarm window 
appears. If you click the OK button, the contents of the message are displayed.

If you select the OK button, the contents of the message are displayed.
If you select the Cancel button, the alarm window appears up to three times at 5 
minute intervals.
You can configure the viewing settings for the text message (SMS) contents on the 
mobile phone. For the procedures, refer to the mobile phone manual.
Some special characters may be displayed as blank or broken characters.

Call Arrival Alarm
If a call arrives while you are watching TV, the alarm window appears.

If you select the OK button, the call arrival alarm is confirmed and the alarm 
window is closed.
If you select the Cancel button, the alarm window appears up to three times at 5 
minute intervals.

Schedule Alarm
While you are watching TV, the alarm window appears to display the registered 
schedule.

If you select the OK button, you can view the contents of the schedule registered 
on the mobile phone.
If you select the Cancel button, the alarm window appears up to three times at 5 
minute intervals.
You can configure the viewing settings for the schedule contents on the mobile 
phone. For the procedures, refer to the mobile phone manual.
Some special characters may be displayed as blank or broken characters.

¦
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Using the Media Function
An alarm window appears informing the user that the media contents (videos, photos, 
music) sent from the mobile phone will be displayed on the TV.
The contents are played automatically 3 seconds after the alarm window appears.
If you press the RETURN or EXIT button when the alarm window appears, the Media 
Contents are not played.

To turn off the media contents transmission from the mobile phone, set Media to 
Off in Setup of the Home Network Centre.
The contents may not be played on the TV depending on their resolution and 
format.

\Media play control buttons
Button Operations

◄/►
Move the cursor and select an item.
While playing a movie file: Skip forwards or backwards 
through the movie file.

ENTERE
Pressing the ENTERE button during play pauses the play.
Pressing the ENTERE button during pause resumes the 
play.

RETURN Return to the previous menu.

TOOLS Run various functions from the Photo, Music and Movie 
menus.

INFO Show file information.
EXIT Stop Media Play mode and Returns to TV mode.

The ENTERE and ◄/► buttons may not work depending on the type of media content. 
Using the mobile device, you can control playing media. For details, refer to each user’s guide.

¦

N

N

N
N

Media will be played from “111-123 4-5671”
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RECOMMENDATIONS

Teletext Feature
Most television stations provide written information services via Teletext. The index page of the teletext service gives you 
information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 
control buttons.

For teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 
some pages may not be displayed. 
You can change teletext pages by pressing the numeric buttons on the remote control.

1   : (exit)
Exit from the teletext display.

2   0 (mode)
Press to select the teletext mode 
(LIST/FLOF). If you press it in the LIST 
mode, it switches into the List save 
mode. In the List save mode, you can 
save teletext page into list using the 
8(store) button.

3   8 (store)
Used to store the teletext pages.

4   4 (size)
Press to display the double-size letters 
in the upper half of the screen. For 
lower half of the screen, press it again. 
To display normal screen, press it once 
again.

5   Colour buttons 
(red/green/yellow/blue)
If the FASTEXT system is used by a 
broadcasting company, the different 
topics covered on a teletext page are 
colour-coded and can be selected by 
pressing the coloured buttons. Press 
one of them corresponding to the 
required. The page is displayed with 
other coloured information that can be 
selected in the same way. To display 
the previous or next page, press the 
corresponding coloured button.

6   / (teletext on/mix)
Press to activate teletext mode after 
selecting the channel providing the teletext 
service. Press it twice to overlap the teletext 
with the current broadcasting screen.

7   5 (reveal)
Used to display the hidden text (answers 
to quiz games, for example). To display 
normal screen, press it again.

8   1 (sub-page)
Used to display the available sub-page.

9   2 (page up)
Used to display the next teletext page.

0   3 (page down)
Used to display the previous teletext page.

!   9 (hold)
Used to hold the display on a given 
page if the selected page is linked with 
several secondary pages which follow on 
automatically. To resume, press it again.

@   6 (index)
Used to display the index (contents) page 
at any time while you are viewing teletext.

#   7 (cancel)
Used to display the broadcast when 
searching for a page.

¦
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The Teletext pages are organized according to six categories:

Part Contents
A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.

Teletext information is often divided between several pages displayed in sequence, which can be accessed by:
Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)
Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.
Depending upon the transmission, blank side panels can occur when displaying Teletext.
In these cases, additional graphics or text is not transmitted.
Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 
Teletext transmission.
Press the TV button to exit from the Teletext display.

Installing the Stand

Preset: Place the Guide Stand and Cover Neck onto the stand and fasten it using the 
screws. Applicable to 32inch models only.

N

1.	 Attach your LCD TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

2.	 Fasten two screws at position 1 and then fasten two screw at position 2.
Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 
placed down, it may lean to one side.
The stand is installed for models with the screen size of 55 inch and above.

N
N

N

N

N

N

N
N
N
N

O

¦

Front

Back
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Disconnecting the Stand

1.	 Remove screws from the back of the TV.
2.	 Separate the stand from the TV.

Two or more people should carry the TV.
3.	 Cover the bottom hole with the cover.

Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the 
Wall Mount items. Contact a technician for assistance when installing the wall mounted 
bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself 
or others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.

Assembling the Cables

Enclose the cables in the Holder-Wire Cable so that the cables are not visible through the 
transparent stand.

Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer.
Refer to the manual provided with the Kensington Lock for proper use. 

The locking device has to be purchased separately.
The location of the Kensington Lock may be different depending on its model.

1.	 Insert the locking device into the Kensington slot on the LCD TV 1 and turn it in the 
locking direction 2.

2.	 Connect the Kensington Lock cable 3.
3.	 Fix the Kensington Lock to a desk or a heavy stationary object.

N
N

3

1

2

¦

N

¦

¦

¦

<Optional>
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Securing the Installation Space
Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation. 
Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature of the product.
Install the product so the required distances shown in the figure are kept.

When using a stand or wall-mount, use parts provided by Samsung Electronics only.
If you use parts provided by another manufacturer, it may result in a problem with the product or an injury due to the 
product falling.
If you use parts provided by another manufacturer, it  may result in a problem with the product or fire due to an increase in 
the internal temperature of the product due to poor ventilation.

The appearance may differ depending on the product.

When installing the product with a stand■ When installing the product with a wall-mount■

Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your children do 
not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious injuries or death. 
Follow all safety precautions provided on the included Safety Flyer. For added stability, install the anti-fall device 
for safety purposes, as follows.

To secure the TV:
1.	 Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.
You may need additional material such as an anchor depending on the type of 
wall.
Since the necessary clamps, screws, and string are not supplied, please 
purchase them separately.

2.	 Remove the screws from the centre back of the TV, put the screws into the clamps, 
and then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications

For a 17 ~ 29 Inch LCD TV: M4 X L15  
For a 32 ~ 40 Inch LCD TV: M6 X L15

3.	 Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
cable.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Remove the cable before moving the TV.

4.	 Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.
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Troubleshooting
If the TV seems to have a problem, first try this list of possible problems and solutions. If none of these troubleshooting tips apply, 
visit samsung.com, then click on Support or call Samsung customer contact centre.

Issue Solution

Picture Quality

First of all, please perform the Picture Test to confirm that your TV is properly displaying 
test image.

Go to MENU - Support - Self Diagnosis - Picture Test
If the test image is properly displayed, the poor picture may caused by the source or signal.
●

TV image does not look as good 
as it did in the store.

If you have an analog Cable/Set top box, upgrade to the box. Use HDMI or Component 
cables to deliver HD picture quality. (Not applied to HD Tuner Built-in models)
Cable/Satellite subscriber : Try HD(High Definition) stations from channel line up.
Antenna connection: Try HD stations after performing Auto program.

Many HD channels are upscaled from SD(Standard Definition) contents.
Adjust Cable/Set top box video output resolution to 1080i or 720p. (Not applied to HD 
Tuner Built-in models)

●

●
●

N
●

Picture is distorted : macroblock, 
small block, dots, pixelization.

Compression of video contents may cause picture distortion especially on fast moving 
pictures such as sports and action movies.
Low signal level can cause picture distortion. This is not a TV issue. Have the antenna 
accessed.

●

●

Wrong or missing color with 
Component connection.

Make sure the Component cables are connected to the correct jacks. Incorrect or loose 
connections may cause color problems or the screen will be blank.

●

Poor color or brightness. Adjust Picture options in the TV menu (Picture mode, Colour, Brightness, 
Sharpness).
Adjust Energy Saving option in Setup menu.
Try picture reset to view the default picture setting (Go to MENU - Picture - Picture 
Reset).

●

●
●

Dotted line on the edge of screen. If picture size is set to Screen Fit, change to 16:9.
Change cable/set top box resolution.

●
●

Picture is black and white with AV 
(Composite) input only.

Confirm Composite (yellow) cable is in yellow jack in source as well as TV.●

Picture freezes or is distorted 
when changing channels or 
picture is delayed.

If connected with Cable/ set top box, please try to reset the cable/set top box. 
(reconnect AC cord and wait until cable box reboots. It may take up to 20 minutes)
Set output resolution of the settop box to 1080i or 720p.

●

●

Sound Quality

First of all, please perform the Sound Test to confirm that your TV audio is properly 
operating.

Go to MENU - Support - Self Diagnosis - Sound Test
If the audio is OK, the sound problem may caused by the source or signal.
●

No sound or sound is too low at 
maximum volume.

Please check the volume of external device connected to your TV. Then, adjust the TV 
volume accordingly.

●

Picture is good but no sound. Set the Speaker Select option to TV speaker in the sound menu.
Make sure audio cables from an external device are connected to correct audio input 
jacks on the TV.
Check connected device’s audio output option.
(ex: You may need to change your external device’s audio option to HDMI when you 
have HDMI connected to your TV.)
If you are using a DVI to HDMI cable, a separate audio cable is required.
Remove plug from headphone jack (if available on your TV).

●
●

●
●

●
●

Noise from speaker. Check cable connections. Make sure a video cable is not connected to an audio input.
For Antenna/Cable connection, check signal strength. Low signal level may cause 
sound distortion.

●
●

¦
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Issue Solution

No Picture, No Video

TV won’t turn on. Make sure the AC power cord is plugged in securely to the wall outlet and the TV.
Make sure the wall outlet is working.
Try pressing the POWER button on the TV to make sure the remote is working 
properly. If the TV turns on, it may be caused by Remote Control. To fix the Remote 
problem, refer to ‘Remote control does not work’ below.

●
●
●

TV turns off automatically. Check if the Sleep Timer is set to On in the Setup menu.
If connected the TV to your PC, check your PC power settings.
Make sure the AC power cord is plugged in securely to the wall outlet and the TV.
If there is no signal for about 10 ~ 15 minutes with Antenna/Cable connection, the TV 
will turn off.

●
●
●
●

No picture/Video. Check cable connections.(remove and reconnect all cables of TV and external devices)
Set your external device’s (Cable/Set top Box, DVD, Blu-ray etc) video output to match 
the connections to the TV input. For example, external device’s output : HDMI , TV’s 
input : HDMI.
Make sure your connected device is powered on.
Make sure to select the TV’s correct source by pressing the SOURCE button on the TV 
remote.

●
●

●
●

RF(Cable/Antenna) Connection

Cannot receive all channels. Make sure Antenna cable is connected securely.
Please try Plug & Play to add available channels to the channel list. Go to MENU - 
Setup - Plug & Play and wait for all available channels are stored.
Verify Antenna is positioned correctly.

●
●

●

Picture is distorted : macroblock, 
small block, dots, pixelization.

Compression of video contents may cause picture distortion especially on fast moving 
pictures such as sports and action movies.
Low signal level can cause picture distortion. This is not a TV issue. Have the antenna 
accessed.

●

●

PC Connection

‘Not Supported Mode’ message. Set your PC’s output resolution so it matches the resolutions supported by the TV.●

PC is always shown on source list  
even if not connected.

This is normal; PC is always shown on the source list even though a PC is not 
connected.

●

Video is OK but there is no audio 
with HDMI connection.

Check the audio output setting on your PC.●

Network Connection

Wireless network connection 
failure.

Samsung Wireless USB dongle is required to use wireless network. (Confirm correct 
dongle is used depending on TV model)
Make sure Network Connection is set to Wireless.
TV must be connected to a wireless IP sharer (Router).

●

●
●
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Issue Solution

Others

Picture is not shown in full screen. Black bars on each side will be shown on HD channels when displaying upscaled SD 
(4:3) contents.
Black bars on Top & Bottom will be shown on movies that have aspect ratios different 
from your TV.
Adjust picture size option on your external device or TV to full screen.

●

●

●

Remote control does not work. Replace the remote control batteries with correct polarity (+ -).
Clean the transmission window located on the top of the remote.
Try pointing the remote directly at the TV from 5~6 feet away.

●
●
●

Can not control TV power or 
volume with Cable/Set top box 
remote control.

Program the Cable/Set top box remote control to operate the TV. Refer to Cable/Set 
top box user manual for SAMSUNG TV code.

●

‘Not Supported Mode’ message. Check the supported resolution of the TV and adjust the external device’s output 
resolution accordingly. Refer to resolution settings in this manual.

●

Plastic smell from TV. This smell is normal and will dissipate over time.●

TV Signal Information is 
unavailable in the Self Diagnostic 
Test menu.

This function is only available with digital channels with an Antenna(RF/Coax) 
connection.

●

TV is tilted to right or left side. Remove the stand base from TV and reassemble.●

Can not assemble stand base. Make sure TV is placed on flat surface. If can not remove screws from TV, please use 
magnetized screw driver.

●

Channel menu is grey out 
(unavailable).

Channel menu is only available when TV source is selected.●

Your settings are lost after 30 
minutes or every time TV is 
turned off.

If TV is in the Store Demo mode, it will reset audio and picture settings every 30 
minutes. Please change from Store Demo mode to Home Use mode in the Plug & 
Play procedure. Press the SOURCE button to select TV mode, go to MENU → Setup 
→ Plug & Play → ENTERE.

●

Intermittent  loss of audio or 
video.

Check cable connections and reconnect.
Can be caused by using overly rigid or thick cables. Make sure the cables are flexible 
enough for long term use. If wall mounting, we recommend using cables with 90 
degree connectors.

●
●

You may see small particles if you 
look closely at the edge of the 
bezel surrounding the TV screen.

This is part of the product’s design and is not a defect.●

Some of above pictures and functions are available at specific models only.N
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Specifications

Model Name LA32B650 LA37B650 LA40B650
Screen Size 
(Diagonal) 32 inch 37 inch 40 inch
PC Resolution
(Optimum) 1920 X 1080 @ 60 Hz 1920 X 1080 @ 60 Hz 1920 X 1080 @ 60 Hz
Sound
Output 10W x 2 10W x 2 10W x 2
Dimension (WxDxH)
Without Stand
With stand

803 X 77 X 545 mm
803 X 239 X 601 mm

927 X 78 X 608 mm
927 X 255 X 668 mm

995 X 79 X 650 mm
995 X 255 X 706 mm

Weight
With Stand 14 kg 17 kg 19 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel 
(Left / Right) -20˚ ~ 20˚

Model Name LA46B650 LA55B650
Screen Size 
(Diagonal) 46 inch 55 inch
PC Resolution
(Optimum) 1920 X 1080 @ 60 Hz 1920 X 1080 @ 60 Hz
Sound
Output 10W x 2 15W x 2
Dimension (WxDxH)
Without Stand
With stand

1126 X 79 X 730 mm
1126 X 277 X 783 mm

1311 x 80 x 842 mm
1311 x 305 x 895 mm

Weight
With Stand 25 kg 35 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel 
(Left / Right) -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.

¦

N
N
N
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